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IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Product description

Kit overview

The Applied Biosystems™ VeriFiler" Plus PCR Amplification Kit is a 6-dye, short
tandem repeat (STR) multiplex assay for the ampilification of specific loci in human
genomic DNA.

The kit amplifies:

* 23 autosomal STR loci: D3S1358, vWA, D16S539, CSF1PO, D6S1043, D8S1179,
D21S11, D18S51, D5S818, D2S441, D19S433, FGA, D10S1248, D2251045,
D1S1656, D13S317, D7S820, Penta E, Penta D, THO1, D12S391, D2S1338, and
TPOX

* Two internal quality control markers (IQCS and IQCL)
* One insertion/deletion polymorphic marker on the Y chromosome (Y indel)

* Amelogenin (sex determining marker)

Internal quality control system for PCR

The VeriFiler" Plus PCR Amplification Kit is an STR kit that includes an internal
quality control (IQC) system for PCR. The IQC system has two synthetic targets,

one low molecular weight and one high molecular weight, that are amplified with the
sample. The behavior of the IQC target peaks can be used to evaluate the success of
the PCR and indicate sample quality.

Validated DNA amounts and PCR cycles

The kit is validated for use with 500 pg of DNA for 29 PCR cycles. The DNA input
volume is 17.5 pL, for a total reaction volume of 25 pL.

VeriFiler™ Plus PCR Amplification Kit User Guide
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About the primers

The VeriFiler" Plus PCR Ampilification Kit primers are manufactured to maximize the
assay signal-to-noise ratio and simplify the interpretation of results.

Table 1 compares the VeriFiler™ Plus kit primers to the VeriFiler" Express PCR
Amplification Kit, GlobalFiler" PCR Amplification Kit, GlobalFiler™ Express PCR
Amplification Kit, and NGM Detect™ PCR Amplification Kit. The VeriFiler™ Plus kit
primers do not contain any mobility modifiers.

Table 2 lists the dyes that are used in the kit.
Table 3 provides the following information about the loci amplified by the kit:
* Locus designation
* Chromosome location
* Alleles included in the VeriFiler™ Plus Allelic Ladder
¢ Dye label
* AmpF{STR™ DNA Control 007 genotype

Changes to the primers in the updated formulation

Artifacts, caused by primers amplifying non-human DNA, were reported by a small
number of laboratories with the original formulation of the VeriFiler" Plus kit. After
internal investigations, we determined that a few primers caused artifact peaks

when DNA from certain bacterial species was present. Accordingly, we extended
primers for the D6S1043, D16S539, Penta E, D18S51, and CSF1PO markers by 1-2
nucleotides and leveraged the design of the IQCL marker from the NGM Detect™

kit and the GlobalFiler™ IQC kit. The primer change for the IQCL marker causes

the marker to size ~15 bp greater in the updated formulation than in the original
formulation. We did not make any other changes to the VeriFiler™ Plus kit formulation,
protocols, or workflow.

The updated formulation of the VeriFiler™ Plus kit was revalidated with internal
and external testing. Other than mitigating the artifact issue, the performance of
the updated formulation is fully comparable to that of the original formulation. In
Chapter 6, “Experiments and results”, all data from the revalidation studies are
labeled with "updated formulation".

VeriFiler™ Plus PCR Amplification Kit User Guide 9
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Primer comparison

Use Table 1 to compare the VeriFiler™ Plus kit to the four kits listed in the table. Do
not use Table 1 to make comparisons between the other kits; for example, do not
compare the VeriFiler" Express kit to the GlobalFiler™ kit.

Note: A concordance population study was performed and genotypes were
compared between the same samples amplified with the VeriFiler™ Plus kit and
the VeriFiler™ Express kit and Huaxia™ Platinum™ kit. For more information, see
“Concordance studies” on page 109.

Table 1 VeriFiler™ Plus kit primer comparison

VeriFiler™ Plus kit compared to...
Marker VeriFiIer":M Express kit and GIobaIFilﬁrm kit and NGM Detect™ kit
Huaxia * Platinum " kit GlobalFiler  Express kit

IQCS Marker not included Marker not included Primers are the same
IQCL Marker not included Marker not included Primers are the same
D2S441 1 primer is the same 1 primer is the same Primers are different
D10S1248 Primers are different Primers are different Primers are different
D22S1045!] Primers are the same Primers are the same Primers are different
D3S1358!] Primers are different Primers are different Primers are different
D8S1179M"] Primers are the same Primers are the same Primers are different
D19S433!"! 1 primer is the same 1 primer is the same Primers are different
D5S818 Primers are different Primers are different Marker not included
VWAL Primers are the same Primers are the same Primers are different
D1S1656 Primers are different Primers are different Primers are different
THO1 1 primer is the same 1 primer is the same Primers are different
D21S11 Primers are the same Primers are the same Primers are different
D13S317 1 primer is the same 1 primer is the same Marker not included
D12S391 Primers are different Primers are different Primers are different
D16S539!"! 1 primer is different 1 primer is different Primers are different
FGAI Primers are the same Primers are the same Primers are different
D18S51 1 primer is the same 1 primer is the same Primers are different
D7S820 Primers are different Primers are different Marker not included
D2S1338 Primers are the same Primers are the same Primers are different

10

VeriFiler™ Plus PCR Amplification Kit User Guide




O

Chapter 1 Product information [

Table 1 VeriFiler Plus kit primer comparison (continued)

Product description

VeriFiler” Plus kit compared to...

Marker VeriFiler™ Express kit and GlobalFiler™ kit and
Huaxia™ Platinum™ kit

GlobalFiler™ Express kit

NGM Detect™ kit

CSF1PO

1 primer is the same

1 primer is the same

Marker not included

TPOX

1 primer is the same

1 primer is the same

Marker not included

D6S104301

Primers are different

Marker not included

Marker not included

Penta DI

Primers are different

Marker not included

Marker not included

Penta E

1 primer is the same

Marker not included

Marker not included

Y indel

Primers are the same

Primers are the same

Primers are the same

AMELL[]

Primers are the same

Primers are the same

Primers are the same

[ The VeriFiler™ Plus kit has one or more additional SNP-specific primers

Dyes used in the kit

Table 2 Dyes used in the VeriFiler” Plus PCR Amplification Kit

Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vIc™ Green
TED™ Yellow
TAZ™ Red
SID™ Purple
Liz"™ Orange GeneScan" 600 LIZ" Size Standard v2.0
Loci amplified by the kit
Table 3 VeriFiler” Plus kit loci and alleles
de;;ﬁ:fion Chlr;’::t’iizme Alleles included in Allelic Ladder Dye label 0%';"2 :::J:L
IQCS — 1,2 6-FAM™ 2
D3S1358 3p21.31 9-20 15,16
VWA 12p13.31 11-24 14,16
D16S539 16924.1 5,8-15 9,10
CSF1PO 5033.3-34 6-15 11,12
11
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Table 3 VeriFiler Plus kit loci and alleles (continued)

Locus Chromosome Alleles included in Allelic Ladder Byslabelt P entel
designation location 007 genotype
D6S1043 6915 7-25 6-FAM™ 12, 14
IQCL — 1,2 2
Y indel Yq11.221 1,2 vic™ 2
Amelogenin Xp22.1-22.3, | X, Y X, Y
Y:p11.2
D8S1179 8g24.13 5-19 12,13
D21S11 21q11.2-g21 |24, 24.2, 25-28, 28.2, 29, 29.2, 30, 30.2, 31, 28, 31
31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2, 36—
38
D18S51 18g21.33  |7,9,10,10.2, 11-13, 13.2, 14, 14.2, 15-27 12,15
D5S818 5g21-31 7-18 11
D2S441 2pl14 8-11,11.3, 12-17 TED™ 14,15
D19S433 19912 5-12,12.2,13, 13.2, 14, 14.2, 15, 15.2, 16, 16.2, 14,15
17,17.2,18.2,19.2
FGA 4928 13-26, 26.2, 27-30, 30.2, 31.2, 32.2, 33.2, 42.2, 24, 26
43.2,44.2,45.2, 46.2, 47.2, 48.2, 49.2, 50.2,
51.2
D10S1248 10g26.3 8-19 12,15
D22S1045 22q12.3 8-19 TAZ" 11,16
D1S1656 1g42.2 9-14,14.3, 15, 15.3, 16, 16.3, 17, 17.3, 18, 18.3, 13, 16
19.3, 20.3
D13S317 13g22-31 | 5-16 11
D7S820 7911.21-22 | 6-15 7,12
Penta E 15026.2 5-26 7,12
Penta D 21g22.3 2.2,3.2,5-17 siD™ 11,12
THO1 11p15.5 4-9,9.3,10-12,13.3 7,9.3
D12S391 12p13.2 14-19, 19.3, 20-27 18,19
D2S1338 2935-37.1 | 11-28 20, 23
TPOX 2p23-2per | 5-15 8

12
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Standards and controls that are required

For the VeriFiler™ Plus kit, the panel of standards needed for PCR amplification, PCR
product sizing, and genotyping are:

* DNA Control 007 —A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the VeriFiler™ Plus Allelic Ladder.
DNA Control 007 is present in the kit. See “DNA Control 007” on page 15.

* GeneScan" 600 LIZ™ Size Standard v2.0—Used for obtaining sizing results.
This standard, which has been evaluated as an internal size standard, yields
precise sizing results for PCR products. Order the GeneScan™ 600 LIZ™ Size
Standard v2.0 (Cat. No. 4408399) separately.

* VeriFiler™ Plus Allelic Ladder—Developed for accurate characterization of the
alleles amplified by the kit. The Allelic Ladder is present in the kit and allows
automatic genotyping of most of the reported alleles for the loci in the kit. See
Figure 1.

Allelic ladder profile

The allelic ladder profile appears on the next page.

VeriFiler™ Plus PCR Amplification Kit User Guide 13
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Figure 1 GeneMapper" ID-X Software plot of the VeriFiler" Plus Allelic Ladder (updated formulation)

The IQCS and IQCL markers are visible as the smallest and largest markers in the FAM™ dye (blue) channel. Each IQC marker has two alleles in the allelic ladder (alleles 1
and 2). However, the IQC markers are not normally analyzed and genotyped because they are primarily intended to be qualitative indicators.
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DNA Control 007
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Figure 2 DNA Control 007 (500 pg) amplified with the VeriFiler” Plus kit and analyzed on an 3500xL Genetic
Analyzer (Y-axis scale 0-18,000 RFU) (updated formulation)

The smallest and largest peaks in the FAM™ dye (blue) channel are the IQCS and IQCL markers, respectively.
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Contents and storage

The VeriFiler" Plus kit (Cat. No. A35495) contains sufficient reagents to perform
200 amplifications with a total reaction volume of 25 pL.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

Table 4 VeriFiler" Plus PCR Amplification Kit (Cat. No. A35495; 200 reactions)

Contents Description Amount Storage
VeriFiler™ Plus Master Contains enzyme, salts, 2 x 0.50 mL —25°C to —15°C on receipt.
Mix dNTPs, bovine serum

2°C to 8°C after first use, for up to
6 months or up to the expiration
date stated on the kit (whichever
comes first).

albumin, and 0.05% sodium
azide in buffer and salt.

VeriFiler™ Plus Primer Set | Contains forward and 2 x0.25mL —-25°C to —15°C on receipt.
E()al\\/leArie pntrners to amplify 2°C to 8°C after first use, for up to
argets. 6 months or up to the expiration
date stated on the kit (whichever
comes first).
Store protected from light.
VeriFiler™ Plus Allelic Contains amplified alleles. 1 x 0.065 mL -25°C to —15°C on receipt.
Ladder See Figure 1 for information. 2°C to 8°C after first use, up to the
expiration date stated on the Kkit.
Store protected from light.
DNA Control 007 Contains 0.1 ng/uL human 1x0.3mL -25°C to —15°C on receipt.

male genomic DNA from cell
line in 0.05% sodium azide
and bufferl!]

See “DNA Control 007” on
page 15 for information.

2°C to 8°C after first use, up to the
expiration date stated on the Kkit.

[ DNA Control 007 is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of the
capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of DNA Control 007, the concentration may differ from the labeled concentration.

Required materials not supplied

See Appendix B, “Materials required but not supplied”.

16 VeriFiler™ Plus PCR Amplification Kit User Guide
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Instruments and software compatibility

Type of instrument or . .
T Validated models or versions
Thermal cyclers * ProFlex™ 96-well PCR System (Cat. No. 4484075)
* ProFlex™ 2 x 96-well PCR System (Cat. No. 4484076)
* ProFlex™ 3 x 32-Well PCR System (Cat. No. 4484073)
e Veriti" 96-Well Thermal Cycler (Cat. No. 4479071)
* GeneAmp" PCR System 9700, 96-Well Silver (Cat. No. N8050001)
* GeneAmp" PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)
Genetic analyzers!'! * 3500/3500xL Genetic Analyzer with any of the following:
- 3500 Series Data Collection Software 1 (Windows™ Vista operating system) and
HID Updater 3500 Data Collection Software v2 (Cat. No. 4480670)
- 3500 Series Data Collection Software 2 (Windows" 7 operating system) and HID
Updater 3500 Data Collection Software v2 (Cat. No. 4480670)
- 3500 Series Data Collection Software 3.1 Upgrade (Windows™ 7 operating
system) (Cat. No. A26287)
- 3500 Series Data Collection Software 3.1 (Windows™ 7 operating system)
(Cat. No. 4475183)
- 3500 Series Data Collection Software 4, v4.0.1 software patch (Windows™ 10
operating system) (Cat. No. A40059 or A40376)
e 3130/3130x/ Genetic Analyzer with:
— 3130 Data Collection Software v4 (Cat. No. 4475105) or 3130x/ Data Collection
Software-v4 (Cat. No. 4475126 ), Windows™ 7 operating system
— 3130/3730 Data Collection v4 6-Dye Module v1 (Cat. No. 4478404)
Analysis software Any of the following GeneMapper™ ID-X Software versions!?!:
* GeneMapper" ID-X Software v1.4 or v1.5; compatible with the Windows™ 7
operating system
* GeneMapper" ID-X Software v1.6 or later; compatible with the Windows™ 7
operating system or Windows™ 10 operating system

" We conducted validation studies using the 3130x/, 3500, and 3500xL configurations.

[l GeneMapper™ ID-X Software v1.2-v1.3 can be used to analyze VeriFiler™ Plus PCR Amplification Kit data. However, some genotype quality
assessment features of the VeriFiler™ Plus kit are not included in earlier versions of the software. See the Chapter 4, “Analyze data with
GeneMapper"ID-X Software” for more details.

IMPORTANT! The VeriFiler" Plus kit should NOT be used with the following
systems:

. ProFlex" 2 x Flat PCR System (Cat. No. 4484078)

. ProFlex™ 2 x 384-well PCR System (Cat. No. 4484077)

. Veriti" Fast 96-Well Thermal Cycler (Cat. No. 4375305)

. GeneAmp™ PCR System 9700 with the aluminium 96-well block (Cat. No.
4314879)

VeriFiler™ Plus PCR Amplification Kit User Guide 17
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0 Workflow

Workflow

Extract DNA, see:

www.thermofisher.com/hid-sampleprep
v

Quantify DNA
“DNA quantification” on page 19

v

Perform PCR

“Prepare the amplification kit reactions” on page 23
v
“Perform PCR” on page 24
v

Perform electrophoresis
“Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)” on page 27 or

“Set up the 3130/3130xI instruments for electrophoresis (before first use of the kit)” on page 31
v
“Prepare samples for electrophoresis” on page 33
v

Analyze data

“Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 37

v

“Create an analysis method” on page 42
v

“Create a size standard definition file if needed” on page 51
v
“Analyze and edit sample files with GeneMapper ID-X Software” on page 53

v

“Examine or edit a project” on page 54
v

Chapter 5, “Assess the PCR reaction with the Internal Quality Control System”

18 VeriFiler™ Plus PCR Amplification Kit User Guide
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DNA quantification

Importance of quantification before STR analysis

DNA quantification can be used to determine:

If the sample contains sufficient human DNA and/or human male DNA to
proceed with short tandem repeat (STR) amplification.

The amount of sample to use in STR analysis applications.

The relative quantities of human male and female DNA in a sample (using the
Quantifiler™ Trio DNA Quantification Kit). This guides selection of the applicable
STR chemistry.

The DNA quality can be evaluated for:
- Inhibition level (using any Quantifiler™ kit)

- DNA degradation level (using the Quantifiler™ Trio DNA Quantification Kit or
Quantifiler™ HP DNA Quantification Kit)

Quality metrics are useful for determining the likelihood of recovery of STR loci
with larger amplicon sizes.

If the sample contains highly degraded DNA. Such samples may require an
alternative approach to STR analysis by capillary electrophoresis. The Thermo
Fisher Scientific Precision ID NGS System and Panels are optimized for
degraded samples. The Precision ID Identity Panel provides discrimination of
individuals similar to STR genotype match probabilities. Also, the Precision ID
Ancestry Panel infers biogeographical ancestry for investigative leads. See
“Related documentation” on page 142 for a list of documents that are related
to the Precision ID NGS System and Panels.

If PCR inhibitors are present in a sample. Such samples may require additional
purification before proceeding to STR analysis.

VeriFiler™ Plus PCR Amplification Kit User Guide 19
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DNA quantification

50 Chapter 2 Perform PCR

Effect of DNA quantity on results

20

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by
the capillary electrophoresis instrument ("off-scale" data).
Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate.
For example, an allele peak that is off-scale can cause a corresponding
stutter peak to appear higher in relative intensity, therefore increasing the
calculated percent stutter.

— Multicomponent analysis of off-scale data are not accurate. This inaccuracy
results in poor spectral separation ("pull-up").

* False signals of inhibition by the IQC system, although none is present.
* A reduction in the IQCL peak height.
* Incomplete +A nucleotide addition.

To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added
to the PCR is extremely low. Unbalanced amplification of the alleles may occur
because of stochastic fluctuation.

VeriFiler™ Plus PCR Amplification Kit User Guide
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Chapter 2 Perform PCR 558

DNA quantification

For information on recent innovations in quantification chemistry, go to
thermofisher.com.

Kit and user guide

Detects

How it works

Quantifiler™ HP DNA
Quantification Kit
(Cat. No. 4482911)

For more information,

see Quantifiler™ HP and
Quantifiler™ Trio DNA
Quantification Kits User
Guide (Pub. No. 4485354)

Total human DNA
(two targets—one
small amplicon and
one larger amplicon)

Degraded DNA

Quantifiler™ Trio DNA
Quantification Kit
(Cat. No. 4482910)

For more information,

see Quantifiler™ HP and
Quantifiler™ Trio DNA
Quantification Kits User
Guide (Pub. No. 4485354)

Total human DNA
(two targets—one
small amplicon and
one larger amplicon)

Human male DNA
Degraded DNA

Uses 5’ nuclease assays with multiple-copy target
loci, for improved detection sensitivity:!'!
— The human-specific target loci are multiple
copy, and dispersed on various autosomal

chromosomes.

— The primary quantification targets have
relatively short amplicons (75-80 bases), to
improve the detection of degraded DNA

samples.

Uses features that maximize the consistency of

quantification:

— Genomic targets have conserved primer- and

probe-binding sites.

— Minimal copy number variation between
different individuals and population groups.

Contains a Large Autosomal target with a longer
amplicon (>200 bases) to help determine if a DNA

sample is degraded.

Contains an Internal PCR control (IPC) 5’ nuclease
assay that amplifies an integrated synthetic DNA
sequence. The performance of this assay can be
used to assess whether real-time PCR of the sample
has been impacted by inhibition.

[ The detection sensitivity of the Quantifiler™ HP Kit and the Quantifiler™ Trio Kit is improved over the Quantifiler™ Duo Kit.

VeriFiler™ Plus PCR Amplification Kit User Guide
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" Before you begin

Before you begin

(Optional) Prepare low-TE buffer

We recommend Invitrogen™ Nuclease-Free Water (Cat. No. AM9937) for sample
preparation. However, you can also use low-TE buffer. Prepare the low-TE buffer
as described in this procedure or use Invitrogen™ TE Buffer (Cat. No. 12090015).

IMPORTANT! Ensure that the low-TE buffer has final concentrations of

10 mM Tris-HCI and 0.1 mM EDTA, pH 8.0. Do not use regular TE buffer because
it has a higher EDTA concentration that can chelate Mg2+ ions, therefore reducing
PCR amplification efficiency and robustness.

1. Mix:
e 10 mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL of nuclease-free water

Note: Adjust the volumes proportionally for specific needs. The final
concentration should be 10 mM Tris-HCI and 0.1 mM EDTA, pH 8.0.

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.
Thaw reagents (before first use of the kit)

Thaw the Master Mix and Primer Set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the
reagents are stored at 2-8°C. Do not refreeze the reagents.

22 VeriFiler™ Plus PCR Amplification Kit User Guide
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

IMPORTANT! Use adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Caps may not provide a consistent seal across all
plate wells.

1. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes,
remove droplets from the caps by centrifuging the tubes briefly.

2. Pipet the required volumes of components into an appropriately sized clear
(non-colored) polypropylene tube:

Component Volume per reaction
Master Mix 5.0 yL
Primer Set 2.5puL

Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

3. Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

4. Dispense 7.5 pL of reaction mixture into each reaction well of a MicroAmp™
Optical 96-Well Reaction Plate or each MicroAmp™ tube.

5. Adjust the sample input amount and volume as needed:

Note: We recommend a DNA input amount of 500 pg.

* |f the total sample input amount is >500 pg of DNA, dilute with nuclease-
free water or low-TE buffer to achieve a 500-pg input in a 17.5-pL volume.

¢ If the total sample input volume is <17.5 pL, bring to volume with nuclease-
free water or low-TE buffer to achieve a 17.5-pL input volume.

6. Prepare the samples as shown in the following table, then add the samples to
the appropriate well or tube (the final reaction volume is 25 pL).

Sample Add
Negative control 17.5 pL of nuclease-free water or low-TE buffer
Test sample 17.5 pL of DNAL!

VeriFiler™ Plus PCR Amplification Kit User Guide 23
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# Chapter 2 Perform PCR

Perform PCR
(continued)
Sample Add
Positive control Combine, then add to the reaction well or tube:
* 5 pL of DNA Control 007 (0.1 ng/pL)
* 12.5 pL of nuclease-free water or low-TE
buffer
M Preparedinstep 5 .
7. Mix until the solution is homogenous.
8. Seal the MicroAmp™ Optical 96-Well Reaction Plate with MicroAmp™ Clear
Adhesive Film or MicroAmp™ Optical Adhesive Film.
9. Centrifuge the tubes or plate at 3,000 rpm for approximately 30 seconds in a
tabletop centrifuge (with plate holders, if using 96-well plates).
Perform PCR
IMPORTANT! This protocol is for casework only. For a direct ampilification protocol,
see the technical note Direct Amplification of Reference Samples Using the VeriFiler™
Plus PCR Amplification Kit.
IMPORTANT! This kit is optimized for use with the thermal cyclers listed in
“Instruments and software compatibility” on page 17.
1. Program the thermal cycling conditions.
IMPORTANT! If you are using the:
. ProFlex™ PCR System, select 9700 Simulation Mode.
. GeneAmp" PCR System 9700, select the Max ramping mode.
. Veriti" Thermal Cycler, set up the method using the Convert a Method tool
and select 9700 Max Mode.
Do not use 9600 emulation mode.
Initial First stage (2 cycles) Second stage (27 cycles) Final Final hold
incubation Denature | Anneal/extend |  Denature Anneal/extend extension
HOLD CYCLE (29 cycles) HOLD HOLD
95°C 96°C 62°C 96°C 59°C 60°C 4°C
1 minute 10 seconds 90 seconds 10 seconds 90 seconds 5 minutes Up to
24 hoursl!l

' The infinity (c0) setting allows an unlimited hold time.

24
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Chapter 2 Perform PCR 5
Direct amplification

2. Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using a GeneAmp"™ PCR System 9700 and adhesive
clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent
evaporation during thermal cycling. The Veriti" Thermal Cycler and the ProFlex™
PCR System do not require a compression pad.

3. When the run is complete, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2°Cto 8°C
>2 weeks —25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.

Direct amplification

The VeriFiler" Plus PCR Amplification Kit is designed and optimized for casework
sample processing (including a pre-amplification extraction and cleanup step) with
VeriFiler™ Express PCR Amplification Kit as the partner kit. The VeriFiler" Express kit
is designed and optimized to perform direct amplification of reference samples.

Some laboratories have expressed a preference for a single PCR amplification kit
capable of processing both casework and reference samples. To support those
laboratories, we have optimized a direct amplification PCR protocol. We performed
studies to demonstrate that the VeriFiler™ Plus kit can be used for direct amplification
of reference samples. Specifically, we evaluated the performance of the kit using a
direct amplification of blood and buccal samples collected on FTA™ cards, NUCLEIC-
CARD™ Devices, Bode Buccal DNA Collectors, blood stain cards made out of filter
paper, and two types of swabs (Puritan™ Cotton Swabs and 4N6FLOQSwabs™).

Note: The direct amplification uses a different PCR protocol. Perform validation
studies before using this kit for direct amplification of single-source samples, or use
the VeriFiler™ Express kit. At PCR cycle numbers <29, the IQC peaks may not be
detected.

For more information on direct amplification studies, go to thermofisher.com,
then search for the technical note Direct Amplification of Reference Samples —
GlobalFiler" PCR Amplification Kit, or contact your local Human ldentification

representative.

VeriFiler™ Plus PCR Amplification Kit User Guide 25
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Allelic ladder requirements for electrophoresis

Materials required for electrophoresis

Perform electrophoresis

Set up the 3500/3500xL instruments for electrophoresis (before first

use of the Kkit)

B Set up the 3130/3130xI instruments for electrophoresis (before first use

of the kit)

B Prepare samples for electrophoresis

To accurately genotype samples, you must run the VeriFiler™ Plus Allelic Ladder with

the samples.
Number of One .
. L Number of samples per allelic
Instrument allelic ladders to | injection
ladder(s)
run equals

3500 1 per 3 8 samples 23 samples + 1 allelic ladder

injections
3500xL 1 per injection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 4 samples 15 samples + 1 allelic ladder

injections
3130x/ 1 per injection 16 samples 15 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between runs. Follow the guidelines in the
preceding table, which should account for normal variation in run speed. Perform
internal validation studies to verify the required allelic ladder injection frequency, to
ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples. Size values obtained for the same sample can differ between instrument
platforms, because of different polymer matrices and electrophoretic conditions.
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Chapter 3 Perform electrophoresis
Materials required for electrophoresis
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Appendix B, “Materials required but not supplied” lists the required materials that are

not supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light

when not in use.

Set up the 3500/3500xL instruments for electrophoresis (before
first use of the kit)

Electrophoresis software setup

The following table lists the data collection software and the run modules that you
can use to analyze PCR products that are generated with this kit. For details on the
procedures, see the documents that are listed in “Documentation and support” on

page 142.
Genetic Operating Data Collection Additional Instrument protocols, run
Analyzerl!] system Software software modules, and conditions
3500 Windows™ Vista | 3500 Data Collection | HID Updater | Set up the following conditions:
3500xL Software v1 3500DCVv2 | o Ryn module: HID36_POP4
(Cat. No. (HID36_POP4xI for 3500xL)
4480670) o .
* Injection conditionsl?!:
1.2 kV/15 sec (24 sec for
3500xL)
®* Run conditions: 13 kV/1,500
sec (13 kV/1,500 sec for
3500xL)
* Dye Set J6-T
3500 Windows™ 7 3500 Data Collection HID Updater | Same as 3500 Data Collection
Software v2 3500 DC v2 Software v1 listed above
3500xL
(Cat. No.
4480670)

VeriFiler™ Plus PCR Amplification Kit User Guide
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28  Chapter 3 Perform electrophoresis

Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)

(continued)

Genetic Operating Data Collection Additional Instrument protocols, run
Analyzerl!] system Software software modules, and conditions
3500 Windows™ 7 | 3500 Data Collection None Same as 3500 Data Collection

3500xL Software v3 Software v1 listed above
3500 Windows™ 10 | 3500 Data Collection None Same as 3500 Data Collection

Software v4, v4.0.1 Software v1 listed above

3500xL
software patch

' We conducted validation studies using the 3130x/, 3500, and 3500xL configurations.

' Our studies indicate that the injection conditions that are documented generate profiles from 0.5 ng of input DNA with heterozygous peak
height averages between 4,000-10,000 RFU (3500 or 3500xL) with no instances of allelic dropout and minimal occurrence of off-scale allele
peaks. However, individual CE instrument signal intensities can vary, therefore changes to injection parameters may need to be explored and
validated to deliver the best results on your specific system. Large deviations from the recommended injection parameters could affect the
performance of the size standard and/or allelic ladder, therefore internal validation studies are recommended.

Create a 3500 QC protocol

28

The VeriFiler™ Plus kit has been validated with data that was analyzed using both the
3rd Order Least Squares method (80-460 base pairs) and the Local Southern method
(60-460 base pairs).

1. In the Library tab, open the QC Protocol window.

2. Create a new QC protocol :

a. Name the new QC protocol according to your laboratory naming

convention.

b. Set the following parameters:

Parameter Setting
Size Standard GS600_LIZ_(60-460)
Size Range Partial
Sizing Start Size 60 bp
Sizing Stop Size 460 bp

Size Calling Method

Local Southern or 3rd Order Least
Squares method

After checking the "Use Baselining" 33
box: Baseline Window Pts.
Peak Window Size 11

VeriFiler™ Plus PCR Amplification Kit User Guide
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Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit) — EaA|

c. Click Save.

B Edit QC Protocol B

Setup a QC Protocol %

* Protocol Name:

Description:

Size Standard: l G5600_LIZ_(60-460) -

Sizecaller: SizeCallervil0 -

Analysis Settings | Qc Settings|

Analysis Range: Sizing Range: Size Calling Method: |Local Southern =

Analysis Start Point: | 0 Sizing Start Size: 60
Analysis Stop Peint: | 1000000 Sizing Stop Size: 460
|| Blue [¥] Green Yellow [7] Red || Purple Orange

Peak Amplitude Threshold

Common Settings

Use Smoothing Light =

Use Baselining (Baseline Window (Pts)) & 33

Minimum Peak Half Width 2

Peak Window Size 11

Polynemial Degree E]
Slope Threshold Peak Start 0o
Slope Threshold Peak End 00

Close Save

3. Add the QC protocol to the HID assay.

Perform spectral calibration

Perform a spectral calibration using the DS-37 (Dye set J6-T, 6-dye) Matrix Standard
Kit (J6-T Dye Set) (Cat. No. A31234).

Note: If it does not already exist, you must create a J6-T Dye Set in the
Data Collection Software before running a spectral calibration. For instructions
on creating a new dye set, see the "Create a New Dye Set" section of the

VeriFiler™ Plus PCR Amplification Kit User Guide 29
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Chapter 3 Perform electrophoresis
Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)

3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v2 User
Guide (Cat. No. 4476988). Use the J6 template to set up the J6-T dye set.

The following figure is an example of a passing 6-dye spectral calibration.

Intemity v Phel Number

BEREEEMD
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Chapter 3 Perform electrophoresis
Set up the 3130/3130x! instruments for electrophoresis (before first use of the kit)

Set up the 3130/3130x/ instruments for electrophoresis (before first
use of the kit)

Electrophoresis software setup
The following table lists the Data Collection Software and the run modules that you

can use to analyze PCR products generated by this kit. For details on the procedures,
see the documents listed in “Documentation and support” on page 142.

Genetic Operatin Data
1 = : Collection | Additional software Run modules and conditions
analyzerl'l system
Software
3130 Windows™ 7 Data 3130/3730 DC v4 | Set up the following conditions:
Collection | 6-Dye Module v1 * HIDFragmentAnalysis36_POP4_1
Software v4 - o
* Injection conditions!?!: 3 kV/4 sec
* Run conditions: 13 kV/1,600 sec
* Dye Set J6-T
3130x/ Set up the following conditions:
¢ HIDFragmentAnalysis36_POP4_1
¢ Injection conditions[?: 3 kV/6 sec
* Run conditions: 13 kV/1,600 sec
* Dye Set J6-T

" We conducted validation studies using the 3130x/, 3500, and 3500xL configurations.

[l Our studies indicate that the injection conditions that are documented generate profiles from 0.5 ng of input DNA with heterozygous peak
height averages between 2,000~ 4,000 RFU (3130 or 3130x/) with no instances of allelic dropout and minimal occurrence of off-scale allele
peaks. However, individual CE instrument signal intensities can vary, therefore changes to injection parameters may need to be explored and
validated to deliver the best results on your specific system. Large deviations from the recommended injection parameters could affect the
performance of the size standard and/or allelic ladder, therefore internal validation studies are recommended.

Obtain and activate 6-dye license

1. Confirm that you are running Data Collection Software v4 (Help » About).

2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact your local Human
Identification representative for information.

3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3130 Series Data Collection Software v4 using
only the network cards that are enabled when you activate the software license.
For example, if you activate the software when your wireless network card is
disabled, you will not be able to run the software when the wireless network
card is enabled.

VeriFiler™ Plus PCR Amplification Kit User Guide 31
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# Chapter 3 Perform electrophoresis
Set up the 3130/3130x! instruments for electrophoresis (before first use of the kit)

4. Select Tools » License Manager to display the Software Activation dialog box.

10.

11.

12.

32

3xnx Series Data Collection Software 4 Software Activation 8

1. Requestlicense file for Computer ID:

d4bed9a7d416 d4bedIaid417

This ID i unigue fo s computer and cannot be used fo obtain 3 ficense e for another computer,

a. Enter the license key (from CD ar email):

b. Enter your email address:

john.doe@thermofisher. com

c. Is this computer currently connected to the internet?

‘Yes., Connected. ] [ Mo. Mot Connected.

2,  Retrieve the license file from email, then save it to the desktop of this computer,

3. Find the license file:

Browse...

4, Click Install and Validate License l

Close

Request the software license file by performing steps 1a, 1b, and 1c as listed on
the activation screen. The license file will be emailed to you.

Obtain the software license file from your email.
Make a copy of the software license file and keep it in a safe location.

Copy the software license file to the desktop of the Data Collection Software v4
computer.

If the Software Activation dialog box has closed, select Tools » License
Manager.

Click Browse, then navigate to the software license file saved on your computer.

Click Install and Validate License.
A message is displayed when the license is installed and validated.

Click Close.

VeriFiler™ Plus PCR Amplification Kit User Guide
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Prepare samples for electrophoresis

Perform spectral calibration

Perform a spectral calibration using the DS-37 (Dye set J6-T, 6-dye) Matrix Standard
Kit (J6-T Dye Set) (Cat. No. A31234).

The following figure is an example of a passing 6-dye spectral calibration.

50 100 150 200 250
Intensity vs Pixel Number

0
1700 1900 2100 2300 2500 2700 2900 3100 3300 3500 3700
Intensity vs Scan Number

Prepare samples for electrophoresis

This procedure applies to the 3130/3130x/ Genetic Analyzer and
3500/3500xL Genetic Analyzer.

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized

polypropylene tube:

Reagent Volume per reaction
GeneScan" 600 LIZ"™ Size Standard v2.0 0.4 uL
Hi-Di"™ Formamide 9.6 uL

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Into each well of a MicroAmp™ Optical 96-Well Reaction Plate, add:
® 10 pL of the formamide/size standard mixture
e 1 pL of PCR product or VeriFiler™ Plus Allelic Ladder

VeriFiler™ Plus PCR Amplification Kit User Guide 33
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Chapter 3 Perform electrophoresis
Prepare samples for electrophoresis

Note: For blank wells, add 10 pL of Hi-Di™" Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.

6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.

VeriFiler™ Plus PCR Amplification Kit User Guide
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m File names and versions used in thissection ............................ 36
®m Set up the GeneMapper™ ID-X Software for analysis (before first use of

the Kit) ..o e 37
B Createananalysismethod ........ ... .. i i 42
B Create a size standard definition fileifneeded ........................... 51
B Analyze and edit sample files with GeneMapper ID-X Software ............ 53
B Examineoreditaproject ...... ... e 54
®m For more information on using the GeneMapper™ ID-X Software .......... 54

Overview of the GeneMapper~ ID-X Software

GeneMapper™ ID-X Software is an automated genotyping software application for
forensic casework, databasing, and paternity data analysis.

GeneMapper™ ID-X Software v1.4 or later analyzes 4-dye, 5-dye, and 6-dye data
and is required to analyze data that is generated using the VeriFiler™ Plus kit. After
electrophoresis, the data collection software stores information for each sample in

a .fsa or .hid file. The GeneMapper" ID-X Software v1.4 or later allows you to analyze
and interpret the data from the .fsa or .hid files.

Earlier versions of GeneMapper" ID-X Software (v1.2 and above) are capable of
analyzing data that is generated using the VeriFiler™ Plus kit. However, some quality
assessment tools are not fully functional on versions earlier than v1.4. Details on
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the data assessment functionality added to specific versions of GeneMapper™ ID-X
Software are found in the release notes for each version. To summarize:

* In versions earlier than v1.4, samples show a red flag for the CGQ if the Y-indel
peak is missing, for example, with a female DNA sample. This occurs because
the absence of the Y-indel peak triggers the Allele Number Rule flag.

Allelic ladder requirements for data analysis

¢ HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies before you use multiple allelic ladder
samples in an analysis.
For multiple allelic ladder samples, the GeneMapper™ ID-X Software calculates
allelic bin offsets by using an average of all allelic ladders that use the same
panel in a run folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run. When the software imports multiple run folders into a project, only the
ladders in their respective run folders are used for calculating allelic bin offsets
and subsequent genotyping.

* Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type
column in a project. Analysis will fail if the Allelic Ladder Sample Type is not
specified.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

File names and versions used in this section

36

The file names and version numbers of panel, bin, and stutter files that are shown in
this section may differ from the file names that you see when you download or import
files.

If you need help to determine the correct files to use, contact your local Human
Identification representative, or go to thermofisher.com/support.
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I

Set up the GeneMapper" ID-X Software for analysis (before first
use of the kit)

Workflow: Set up GeneMapper™ ID-X Software

Before you use GeneMapper" ID-X Software to analyze data for the first time, you
must do the following:

“Check panel, bin, and stutter file versions on your computer” on page 37
v
“(If needed) Download newer versions of panel, bin, and stutter files” on page 38
v
“Import panels, bins, and marker stutter” on page 38
v

“(Optional) Define custom table or plot settings” on page 42

Check panel, bin, and stutter file versions on your computer

1. Start the GeneMapper" ID-X Software , then log in with the appropriate user
name and password.

2. Select Tools » Panel Manager.
3. Check the version of files that are currently available in the Panel Manager:

a. Select Panel Manager in the
navigation pane.

¥ Panel Manager

File Edit Bins View Help

b. Expand the Panel Manager
folder and any subfolders to
identify the analysis file version
that is already installed for your kit choice.

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the
Import Panels dialog box.

b. Navigate to, then open the Panels folder, then check the version of panel,
bin, and stutter files installed.

5. Check for newer versions of the files as described in the next procedure.
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(If needed) Download newer versions of panel, bin, and stutter files
1. Go to www.thermofisher.com/GMIDXsoftware.

2. If the file versions listed are newer than the versions on your computer,
download the file VeriFiler Plus Analysis Files.

Note: When downloading new versions of analysis files, see the associated
Read Me file for details of changes between software file versions. Perform the
appropriate internal validation studies before using new file versions for analysis.

3. Unzip the file.
Import panels, bins, and marker stutter

To import the latest panel, bin set, and marker stutter from the website into the
GeneMapper" ID-X Software database:

1. Start the GeneMapper™ ID-X Software, then log in with the appropriate user
name and password.

2. Select Tools » Panel Manager. # Panel Manager |

File Edit Bins View Help

3. Find, then open the folder containing
the panels, bins, and marker stutter:

a. Select Panel Manager, then select File » Import Panels to open the
Import Panels dialog box.

b. Navigate to, then open the VeriFiler Plus Analysis Files folder that you
unzipped in the previous procedure.

4. Select VeriFiler_Plus_Panel.txt, then click Import.

Note: Importing this file creates a new folder in the Panel Manager navigation
pane, VeriFiler_Plus_Panel. This folder contains the panel and associated
markers.
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- — H

Look in: [ . Panels

- EE

I || VeriFiler_Plus_Bins_w1 .tet
e & VeriFiler_Plus_Panel_v1.txt

Recent Items

L

Desktop

|| VeriFiler_Plus_Stutter_vl.txt

B J File name;

My Docu

|'u'eriFiIer_PIus_P'aneI_vl.txt
ments  Files of type: [.MJ Files

5. Import the bins file:

a. In the Panel Manager navigation pane, click the VeriFiler_Plus folder to
display the VeriFiler_Plus_Panel.

¥ Panel Manager l 23 I
Eile Edit Bins View Help

w X (o HE |- |Bin5et:F

= o Panel Manager

liaE s BNEEEEE|
-~ Parwel Hame
L) AmpFLSTR_Panels_v3X

=

1
- [C)NGM_Detect_v1

Commrmerit

eriFiler_Flus_Panel

il

- ICVeriFiler_Plus_Panel

I |

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the VeriFiler Plus Analysis Files folder.
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d. Select VeriFiler_Plus_Bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
VeriFiler_Plus_Panel folder.

Lookin: | |, Panels

B VeriFiler Plus Bins v1.bt

|| VeriFiler_Plus_Panel_w1.tt
Recent Items | VeriFiler_Plus_Stutter_v1.bd

-ﬂ

Desktop

[1| File name: VeriFiler_Plus_Bins_v 1.tk

My Documents  Files of type: | all Files

6. (Optional) View information about panels and bins: In the Panel Manager
navigation pane, click + next to the VeriFiler_Plus folder, then click + next to
the VeriFiler_Plus_Panel folder to reveal marker-level information.

Note: Select the Y Marker checkbox to avoid flagging female samples.

The panel view is shown below.

| Panel Manager
| File Edit Bins View Help
i > | W W | W™ | nset: [verrier_Plus_Bns JHwE®EE EEEEEEE | e
=+ g Panel Manager Mitker Mame | Dye Color | B Sime | M Sim | Corarol Alleles Mikier | Conmares  Mer | Ladder Alleles
[ AmpFLSTR_Panels 3 1 o= Bue  |sz0 1420|1516 4 |rone ] [310,11,12,1514,15,16,17
- [CanGM Detect v1 2 |wwa Elue 1450 [2150 14,16 4 none & 11,12,13,14,15,16,17, 18,1
= VE"S = 3 |Dlessas Bl |221.5 |273.5 (9,10 4 none @l 5,6,9,10,11,12,13,14,15
e 4 |CFIRD [pe [zrro m0 (12 4 |rone T [6788,10,1L12,13,14,15
5 Desload (B (3270 (4150 (12,14 4 |rone O [7&510,11,12,15,14,151¢
5 [Yindel Green 795 575 |2 5 |rone 1z
7 [AMEL Green (1000 [11LD |y 9 |none S
- gl Reference Samples 3 |pesiiFa Green (1130|1765 |12,13 4 |rone O] [567.8210,11,12,15,14,1
5 [petsil Green  |173.5 (2465 |om3l 4 |rone [ |z4.24.2,2525,27,28,28.,¢
10 |D1asS1 Green |55 (900 |1215 4 |rone O [7e1010211,12,15132,
11 |DEsELE Green (w00 (4200 |11 4 |rone B [78310,11,12,15,14,15,1¢
12 |D2s44t velaw (300 1250|1315 4 |rone T (88l0IL10312,13,14,1
13 |D1a5433 Velaw 1300 (2020|1315 4 |rone F 567831011,12,12.2,1
14 FGA Velaw (2040 |60 |2%,26 4 |rone O [1314,1515,17,15,18,202
1501051298 |velow |367.0 4230 (12,15 4 |none O [B81015,12,15,14,15,16,
1602251095 Red  |@a&  |1266  |1L16 3 |rone O [B810,15,12,15,14,15,16,
17 |Distesa Red  |1s0.0 (1970|1316 4 |rone ] [3I011,12,1514,145,15,
18 |D135317 Red (1930 |25aa |11 4 |rone [ [5678210,11,12,13,14,1
19 |D7sER0 Red  |emsn g0za |7,12 4 |rone B [678810,11,12,13,14,15
20 |PertaE Red |40 4250|712 5 |rone T [567631011,12,13,141
21 [PertaD Puple (750 (1620|1112 5 |rone B 223256783,101L,12
22 |THOIL Fuple (1640 21L0 |7,93 4 |rone 0 [4567,895.510,11,12,
23 |D1253a1 Puple (2130 (2730|1819 4 |none O |1415,16,17,15,15,1.3,20
24 Desiaz Puple (2760|3555 |20,23 4 |none O [1L13,13,14,15,16,17,18,1
25 |TROK Furple (@80 (4150 |8 4 |rone O] [567.8210,11,12,15,14,1
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1]y ]

7. Import the stutter file:

a. Select the VeriFiler_Plus_Panel folder in the navigation pane.

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

c. Navigate to, then open the VeriFiler Plus Analysis Files folder.

d. Select VeriFiler_Plus_Stutter_v1.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin
set in the VeriFiler_Plus folder and overwrites any existing stutter ratios
associated with the panels and bins in that folder.

e ==

- 2 rE=

Look in:

|, Panels

T || VeriFiler_Plus_Bins_vl.txt
-:rﬁ || VeriFiler_Plus_Panel_v1.tt
Recent Items - VerFiler_Plus_Stutter vl .bd

File name: VeriFiler_Plus_Stutter_wi1.txt

My Documents  Files of type: [ all Files

8. View the imported marker stutters in the navigation pane:

a. Click + next to the VeriFiler_Plus and VeriFiler_Plus_Panel folders.
The list of markers is displayed.

b. Double-click a marker to display the Stutter Ratio & Distance view for the
marker in the right pane.

File Edit Bins View Help
ll=F > | Bf ® W | W ™= | 6nset: |Verrier_Plus Bins
|y VeriFiler_Plus

[=-{CVeriFiler_Plus_Panel
£ D351358

WS EEOEGENR | @

Please enter the stutter filter(s) for D3S1358 marker here If left blank, the global stutter filter will be
applied

B

Minus Stutter

Ratio

From Distance

To Distance

Plus Stutter

Ratio

From Distance

To Distance

L1261

3.25

4.75

L0374

3.25

4.75

D8s1179

vy ey

D21511
e i v
aF,Reference Samples ‘

1
2
3
3
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9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the
GeneMapper" ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter are not imported into the GeneMapper™ ID-X
Software database.

(Optional) Define custom table or plot settings

Default views for table and plot settings are provided with the software. For
information on defining custom views, see GeneMapper" ID-X Software Getting
Started Guide— Basic Features.

Create an analysis method

Create an analysis method

IMPORTANT! Analysis methods are version-specific, so you must create an
analysis method for each version of the software. For example, an analysis method
that is created in GeneMapper™ ID-X Software version 1.2 is not compatible

with analysis methods that are created in earlier versions of software, or with
GeneMapper™ Software v3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper ID-X
Manager.

7 oo D tee

Find Name Containing:

Projects | Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards | Report Settings
[ Mew. -« |[ Open... ][ Save As... ] Import... ][ Export... | Delete

2. Click the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.
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Enter Analysis Method settings

Enter General tab settings

1. Enter a Name and select the Security Group appropriate for your software
configuration.

-

Analysis Method Editor > - S

General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings|

—Analysis Method Description

Mame: ".l'EriFi|EF_P|US_AI'|E|}'SiS_MEﬂ‘|Dd|

Security Group: .GeneMapper ID-X Security Group - .

Description: -
=

| |
Instrument:
Analysis Type: HID

[ Save H Cancel H Help ]

S

2. (Optional) Enter a Description and Instrument.
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Enter Allele tab settings

IMPORTANT! Perform appropriate internal validation studies to determine the

appropriate settings to use.

1. Select the VeriFiler_Plus_Bins_v1 bin set.

' Analysis Method Edita

| General | Allele | peak Detector | Peak Quality | SQ & GQ Settings |

Bin Set: .?u'eriFiler_PIus_Bins

IUse marker-specific stutter ratio and distance if available

Marker Repeat Type:
Global Cut-off Value
MinusA Ratio

MinusA Distance

Global Minus Stutter Ratio

Global Minus Stutter Distance  From
To

Global Plus Stutter Ratio

Global Plus Stutter Distance

Tri
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

Tetra
0.0
0.0
0.0
0.0
0.0
3.25
4,75
0.0
0.0
0.0

Amelogenin Cutoff

Range Filter...

Factory Defaults

[ Save H Cancel H Help ]

Figure 3 Settings used in developmental validation of the kit

2. (Optional) To apply the stutter ratios contained in the
VeriFiler_Plus_Stutter_v1.txt, select the Use marker-specific stutter ratio
and distance if available checkbox (selected by default).
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Create an analysis method

3. If you use global stutter filters instead of marker-specific stutters, enter values
for Tri-, Tetra-, and Penta-nucleotide repeats.

Note: Using global stutter filters instead of marker-specific stutters is not

typical.

Note: There are no hexa-nucleotide repeat markers in the VeriFiler™ Plus kit.

4. Enter the appropriate filter settings.

Enter Peak Detector tab settings

Enter the appropriate values:

Field

Values to enter or select

Additional information

Ranges

Enter the values shown in Figure 4.

Note: The read region for the VeriFiler™ Plus
it is 75-426 bp.

Peak Detection

Enter the appropriate settings.

IMPORTANT! Perform appropriate internal
validation studies to determine the
appropriate peak amplitude thresholds for
interpretation of data.

The software uses the Peak Amplitude
Thresholds to specify the minimum

peak height. Although GeneMapper" ID-X
Software displays peaks that fall below the
specified amplitude in electropherograms,
the software does not label or determine the
genotype of these peaks.

Note: As shown in Figure 4, there

are additional Peak Detection parameters,
including Min. Peak Half Width, Polynomial
Degree, Peak Window Size, and Slope
Threshold.

Smoothing and
Baseline

Enter the values shown in Figure 4.

VeriFiler™ Plus PCR Amplification Kit User Guide
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Field

Values to enter or select

Additional information

Size Calling Method

Select Local Southern Method or 3rd Order
Least Squares, or another method that

has been validated during your internal
validation studies.

The VeriFiler™ Plus kit has been validated
using both the 3rd Order Least Squares
sizing method (80-460 bp) and the Local
Southern sizing method (60-460 bp).

Both sizing methods produced 100%
concordance and generated acceptable
data. Select alternative sizing methods only
after performing the appropriate internal
validation studies.

Normalization

(Optional) Select the Normalization
checkbox.

A Normalization checkbox is available on
this tab in GeneMapper " ID-X Software
for use with data that are run on the
3500/3500xL Genetic Analyzer.

46

IMPORTANT! Both the 3rd Order Least Squares Sizing algorithm and the Local
Southern Sizing algorithm have been validated for analysis of VeriFiler Plus kit data

on 3130- and 3500-series instruments.

Note: The read region for the VeriFiler" Plus kit is 75-426 bp.
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Create an analysis method @i |

"=y

Analysis Method Editor e S

General | Allele | Peak Detector | peak Quality | 5Q & GQ Settings |

Peak Detection Algorithm: Advanced

Ranges Peak Detection

Analysis . Sizing _ Peak Amplitude Thresholds:

Full Range v | Al Sizes Ll B: TBD R | TBD
Start Pt:| 0 Start Size:| 0

G TED p: | TBD
Y: TBD o | TBD

Stop Pt: (10000 Stop Size: | 1000

—Smoothing and Baselining
_ ) Min. Peak Half width: |2 pts
Smoothing ) Mone
: i : 3
@ Light Polynomial Dearee
(") Heavy Peak Window Size: 11 pts
Baseline Window: 33 pis Slope Threshold
Peak Start: 0.0
—Size Calling Method Pk Ends 0.0
(™) 2nd Crder Least Squares
(™) 3rd Order Least Squares Marmalization
Cubic Spline Interpolation [] Use Mormalization, if applicable
@ Local Southern Method
(") Global Southern Method

’ Factory Defaults

[ Save H Cancel H Help ]

Figure 4 Settings used in developmental validation of the kit

IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories must perform the appropriate internal studies to determine the peak
amplitude thresholds for interpreting the VeriFiler™ Plus kit data.
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Create an analysis method

Enter Peak Quality tab settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak

height threshold, and the minimum peak height ratio threshold for interpretation of
data.

Enter the following values:

Analysis Method Editor

| General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |

MinMax Peak Height (LPH/MPH)
Homozygous min peak height TBD
Heterozygous min peak height TBD
Max Peak Height (MPH) TBD
Peak Height Ratio (FHR)
Min peak height ratio TBD
Broad Peak (ED)
Max peak width (basepairs) 1.5
Allele Mumber (AM)
Max expected alleles:

For autosomal markers & AMEL 2

Far ¥ markers 1
Allelic Ladder Spike
Spike Detection Enable +
Cut-off Value 0.2
Sample Spike Detection
Spike Detection :Enable -

’ Factory Defaults
[ Save ] [ Cancel ] [ Help ]
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IMPORTANT! TBD indicates values to be determined in your laboratory.
Laboratories must perform the appropriate internal studies to determine the peak
amplitude thresholds for interpreting the VeriFiler" Plus kit data.
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Enter SQ and GQ tab settings

IMPORTANT! The values that are shown are the software defaults and are the
values that we used during developmental validation. Perform appropriate internal
validation studies to determine the appropriate values to use.

Enter the following values:

| General | Allele | Peak Detector | Peak Quality | 5Q &GQ Settings |

Quality weights are between 0 and 1.

~Sample and Control GQ Weighting
Broad Peak (BD) 0.5| Allele Number (AN) 1.0
Out of Bin Allele (BIN) 0.8 Low Peak Height (LPH) 0.3
Overiap (OVL) 0.8 Max Peak Height (MPH) 0.3
|| Marker Spike (sPK) 0.3 Off-scale (0S) 0.8
AMEL Cross Check (ACC)  |0.0 Peak Height Ratio (PHR)  |0.3

Control Concordance (CC) Weight = 1.0 (Only applicable to controls)

~50 Weighiting

Broad Peak (BD) 0.5
~Alelc Ladder GO Weighting

Spike (SSPK/SPK) 1w Off-scale (0S) 1w
[5Q &GO Ranges

- PassRenge:  [GWIOUSHEIRERGEIN
Sizng Quality:  From 0.75 | tol0 From0.0to |0.25

Genotype Quality: From |0.75 to 1.0 FromQ.0to |0.25

[ Reset Defaults I

[ Sevess |[ save || Cond |[ Heb |

Note: Set the ACC GQ Weighting according to the values you determine during
internal validation studies of the ACC PQV. For example, set the ACC GQ Weighting
to 0.3 or greater to flag samples in which the Amelogenin result is anything other than
X, X or X, Y, or does not agree with the results for the Y indel marker.
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Create a size standard definition file if needed

If you cannot use the default settings that are provided, create a new size standard
definition file.

About the GS600_LIZ_(60-460) size standard definition file

The GS600_LIZ_(60-460) size standard definition that is provided with GeneMapper '
ID-X Software and used with the Local Southern size calling method contains the
following peaks: 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260,
280, 300, 314, 320, 340, 360, 380, 400, 414, 420, 440, and 460.

This size standard definition has been validated for use with this kit on the genetic
analyzers listed in “Instruments and software compatibility” on page 17. If you need
to create your own size standard definition, see “Create a size standard definition file”
on page 51.

Create a size standard definition file

1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X
Manager.

2. Click the Size Standards tab, then click New.

Find Mame Containing:

| Projects | Ansiysis Methods | Table Settings | Plot Settings | Matrices | Sze Standards | Report Settings |

Mame Last Saved covries Type Description
CE_F_HID_GSS00 (75-400) |2007-08-09 13:23:% | gmidx |Advanced

CE_F_HID_GSS00 (75-450) |m:|?-us-nq |3:24:[f.;wudx Advanced |
CE_G5_HID_G5500 2006-10-11 13:12:% | gmic:: Advanced

|GS600_LIZ 2007-06-26 10:43:1 | gridx | Acdvanced
G5600_LIZ+Mormalization_{ |m:z-m-ns I2:3?::i|;mdx Advanced |

(35600 _LIZ+Normalization_{ [2007-06-27 01:43:1| gmid:x Achvancad

| GSE00_LIZ_{G0-460) 2012-06-06 12:21+7 | grid | Advanced

GSE00_LIZ_(B0-400) |znm-ne-2? 01:43: I:wmdx Advanced |

E 31

3. Specify settings in the Size Standard Editor:
a. Enter a name as shown in the following figure or enter a new name.

VeriFiler™ Plus PCR Amplification Kit User Guide 51



lgm Chapter 4 Analyze data with GeneMapper™ ID-X Software
{58  Create a size standard definition file if needed

b. In the Security Group field, select the Security Group appropriate for your
software configuration.
c. In the Size Standard Dye field, select Orange.

d. In the Size Standard Table, enter the peak sizes that correspond to your
size standard.

Fa |

| 4? Size Standard Editor

Edit
—Size Standard Description

Mame: GSa00_LIZ_{50-460)
Security Group: :GeneMapper ID-X Security Group -

Description:

{ | size Standard Dye: :Drange -

—Size Standard Table

Size in Basepairs
1 |00 I -

[ Insert H Delete ]

2 (800

3 (1000

4 |114.0

120.0
[

6 (140.0

m

j 7 [160.0

g8 (1500

9 [Z00.0

10 (214.0

11 2200

12 |240.0

13 (2500

14 [260.0

15 [ZG60.0

16 (300.0

17 [314.0

[ QK H Cancel ][ Help ]
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Analyze and edit sample files with GeneMapper ID-X Software
1. In the Project window, select Edit » Add Samples to Project, then navigate to
the disk or directory that contains the sample files.
2. Apply analysis settings to the samples in the project.
Parameter Settings
Sample Type Select the sample type.
Analysis Method Select VeriFiler Plus Analysis Method (or the name of the
analysis method you created).
Panel Select VeriFiler_Plus_Panel.
Size Standard Use a size range of 60—460 bp for Local Southern size-calling
method or a size range of 80— 460 bp for 3rd Order Least
Squares size-calling method. ']

' The VeriFiler™ Plus kit was originally validated for use with the GeneScan™ 600 LIZ™ Size Standard
v2.0. If you use a different size standard, perform the appropriate internal validation studies to support
the use of this size standard with the VeriFiler™ Plus kit.

3. Click Analyze, enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

* The status bar displays the progress of analysis as a completion bar.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Analysis Summary tab is displayed, and the Genotypes tab is
available when the analysis is complete.

% ———— : -
‘GEHEMEHFHQ 1D-X - VeriFiler Plus Analysis Example - gmidx Is Logg

File Edit Analysis View Tools Admin Help

=a=N | ‘ % F ‘ m & HE W ‘ BEEAE ‘ > ‘Tah\ESEthng 3500 Data Analysis -m| P &R ‘ 0 e
E.zgj;:msgnu Samples | Analysis Summary |Genmpes|

Analysis Summary

Select run folder to display: | 100052011 1710001 040ct17
Sample Status Total # of Samples ]
% Unanalyzed [} |
Analyzed 36 |
U Analysis Setting Changed o |
Click a link below to display a filtered Samples Table containing only the samples selected
Allelic Ladder Quality per run folder (based on SQ and 0GQ only)
Run Folder J[ Toml #ofAnalyzed ladders | Ca T & ]
100058011 1710001 04017 | 5 | &6 | o [ o |
Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, $Q, CGQ)
Control Type Total # of Samples Al tresholds met @ One or more thresholds notmet |
Positive Control 0 0 0
Custom Control 0 0 0
Negative Control 0 0 0
[Total 0 o 0
‘Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, 50, C6Q)
|| Total = of samples I Allthvesholdsmet || @) One or more thresholds notmet |
|samples 30 24 | 5 |

< [ 3| EA! m '

Analysis Completed.
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%

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project
window to examine the data.

For more information on using the GeneMapperTM ID-X Software

See “Related documentation” on page 142 for a list of available documents.
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Assess the PCR reaction with the
Internal Quality Control System

m Overview of the Internal Quality Control system .......................... 55

B Evaluate the PCR reaction

Overview of the Internal Quality Control system

The Internal Quality Control (IQC) System is a tool that can help you evaluate the PCR
reaction and, along with the STR marker data, infer possible sample degradation or
inhibition.

The primers for the two IQC markers, IQCS and IQCL, amplify synthetic DNA targets
that are included in the primer mix. IQCS is a low molecular weight amplicon, with
mobility of 70 nt. IQCL is a higher molecular weight amplicon, with mobility of 451 nt.

Note: The IQC markers enable qualitative insight into the sample amplification. By
default, the IQC markers are not genotyped during analysis in the GeneMapper™
ID-X Software. However, if needed, the VeriFiler" Plus Allelic Ladder contains two
peaks each for the IQCS and IQCL markers (designated 1 and 2) to detect the IQC
sequences. Sample reactions contain one peak each for IQCS and IQCL, which
corresponds to the larger peak (peak 2) in each IQC marker.

The IQC System allows you to:

* Confirm the success or failure of the PCR reaction, by looking for the presence
or absence of the IQCS and IQCL primer peaks on the electropherogram.

* Determine if PCR inhibitors might be present in the PCR reaction, or if the PCR
reaction conditions are not optimal, by evaluating the peak heights of IQCS and
IQCL.

Evaluate the PCR reaction

To evaluate the PCR performance of the samples, review the peak heights of

the IQCS and IQCL. Under ideal PCR conditions, the peak heights of the IQCS
and IQCL should be >2,000 RFU using standard injection protocols on the
3500/3500xL Genetic Analyzer (see Table 5). Under suboptimal PCR conditions
(for example, moderate inhibition), the height of the IQCL is substantially reduced.
Under extremely high inhibition, even the small IQC peak heights are substantially
reduced. Note that when high inputs of DNA are amplified (greater than 2 ng) some
suppression of the IQCL peak may also be seen.
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s
Evaluate the PCR reaction
See Table 5 for outcome scenarios.
Note: The electropherograms that are shown in Figure 5 through Figure 10 are from
runs on a 3500xL Genetic Analyzer using standard injection protocols.
Table 5 1QC peak interpretation
IQC interpretation
SampI?IDNA IQC peaks Recommended action for re-amplification(!]
protile Typically indicates...
Balanced Both IQC peaks PCR performance within the | Re-amplification should not be required. On
are >2,000 RFU optimal range—no sample a case-by-case basis, you can evaluate the
degradation or inhibition (see | profile and determine if re-amplification is
Figure 5) required.
Balanced The IQCS peak Mild inhibition (see Figure 6) Evaluate the profile and determine if additional
height is > input would recover alleles without saturating
2,000 RFU, the system.
while the IQCL
peak height
is significantly
decreased
Ski-slope The IQCS peak High inhibition (see Figure 7) Perform a dilution or dilutions of the sample
height is near to minimize the inhibitor while still allowing
2,000 RFU or for enough DNA to achieve amplification (for
greater, while the example, 10-20% dilution).
IQCL peak is not
present
Ski-slope The IQCS Very high inhibition Perform a dilution or dilutions of the sample
peak height (see Figure 8) to minimize the inhibitor while still allowing
is significantly for enough DNA to achieve amplification (for
decreased, while example, 20-60% dilution).
the IQCL peak is
not present
Ski-slope Both IQC peaks Degraded sample DNA Evaluate the profile and determine if additional
are >2,000 RFU (see Figure 9) input would recover alleles without saturating
the system.

56
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Table 5 1QC peak interpretation (continued)

IQC interpretation
Samplc:_IDNA IQC peaks Recommended action for re-amplification(!]
protile Typically indicates...
No peaks Both IQC peaks No DNA or very little sample Check the quantification and normalization
are >2,000 RFU DNA (see Figure 10) calculations. If you have sufficient DNA to

generate a profile, increase the amount of DNA
in the amplification.

No peaks No peaks PCR failure or ultra-high Re-amplify the sample at the appropriate
inhibition target to determine if PCR failure occurred. If
DNA is still not detected, perform a dilution

or dilutions of the sample to minimize the
inhibitor while still allowing for enough DNA

to achieve amplification (for example, 20-60%
dilution).

1 The decision to re-amplify the sample should be based on individual laboratory protocols that identify how much information is sufficient for
reporting.

Balanced profile

In this example of a balanced profile, the IQC peaks and the DNA profile peaks are
balanced, which indicates that PCR has occurred optimally.

B0 100 140 180 220 260 300 340 350 420 460

20000
AE000:
12000

2000
4000
o . |

Figure 5 FAM™ dye channel electropherogram that shows IQCS and IQCL peaks with 0.5 ng of DNA (scaled
to 22,000 RFU) (updated formulation)

The red circle highlights the IQCS peak and the green circle highlights the IQCL peak.
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Ski slope profile with decreased IQCL peak height

Figure 6 shows a significantly lower IQCL peak height. This indicates that the PCR
reaction has been compromised by inhibition. Figure 7 shows the complete absence
of an IQCL peak, indicating a high level of inhibition.

E0 100 140 180 220 40 280 a20 HED

20000

260 200
16000
12000
&000
4000 l l l
ol i 8. i i 2 B "

Figure 6 Combined dyes electropherogram for the VeriFiler™ Plus kit in the presence of 150 ng/uL of humic acid
(scaled to 22,000 RFU) (updated formulation)

The red circle highlights the IQCS peak (a PCR inhibitor) and the green circle highlights the IQCL peak. While overall peak heights
are reduced relative to the uninhibited control sample, only a subtle ski-slope effect is observed.

SIJEIEISU 400 140 180 220 260 200 240 380 420 4E0

- T
(1) N ol e 0

Figure 7 Combined dyes electropherogram for the VeriFiler™ Plus kit in the presence of 350 ng/pL of humic acid
(scaled to 5,000 RFU) (updated formulation)

The red circle highlights the IQCS peak; the IQCL peak is absent (green box). The arrow indicates the ski slope peak pattern
observed in the DNA profile.

Ski slope profile with IQC peaks

The presence of both IQCS and IQCL peaks >2,000 RFU indicates that PCR has
occurred optimally.

&0 100 140 180 220 260 300 340 380 420 460

Figure 8 Combined dyes electropherogram for the VeriFiler™ Plus PCR Amplification Kit in the presence of
450 ng/pL of humic acid (updated formulation)

The red circle highlights the IQCS peak; the IQCL peak is absent (green circle). The arrow indicates the ski slope peak pattern
observed in the DNA profile. The Y-axis is scaled to 250 RFU to make extremely low peaks visible.
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Figure 9 Combined dyes electropherogram from degraded DNA (scaled to 10,000 RFU) (updated formulation)

340 380 420 460

The red circle highlights the IQCS peak and the green circle highlights the IQCL peak. The arrow indicates the ski slope pattern
observed in the DNA profile.

No sample peaks with IQC peaks

There are no DNA profile peaks in Figure 10. However, the presence of both the IQCS
and IQCL peaks indicates that normal amplification has occurred in the PCR.

B0 100 140 180 220 260 300 340 380 420 460
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Figure 10 Combined dyes electropherogram that shows IQCS and IQCL peaks with 0 ng of DNA (scaled to
16,000 RFU) (updated formulation)

The red circle highlights the IQCS peak and the green circle highlights the IQCL peak.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is

an evaluation of the efficiency, reliability, and performance characteristics of

the procedure. By challenging the procedure with samples that are commonly
encountered in forensic and parentage laboratories, the validation process uncovers
attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

60

We conducted developmental validation experiments according to the updated and
revised guidelines from the Scientific Working Group on DNA Analysis Methods
(SWGDAM, December 2016). Based on these guidelines, we conducted experiments
that comply with guidelines 2.0 and 3.0 and its associated subsections. This DNA
methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al., 2002;
and Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met
reproducible performance standards. It is our opinion that while these experiments
are not exhaustive, they are appropriate for a manufacturer of STR kits intended for
forensic and/or parentage testing use.

VeriFiler™ Plus PCR Amplification Kit User Guide



]
K

Chapter 6 Experiments and results
Laboratory requirements for internal validation

02
=

Repeated validation experiments using the updated formulation

Minor modifications were made to the VeriFiler" Plus PCR Amplification Kit primer
mix to reduce the incidence of non-specific PCR artifacts that were observed in
certain forensic samples with high microbial DNA load. Accordingly, we used the
updated formulation to repeat the validation experiments that might be impacted by
the primer mix changes, as follows:

* Developmental validation—“PCR components” on page 62

* Extra peaks—“Dye artifact observation” on page 91

* Species Specificity —“Nonhuman studies” on page 95

¢ Sensitivity —“Sensitivity observation” on page 97

* Stability—“Degraded DNA” on page 98

¢ Stability—“Effect of inhibitors” on page 99

* Mixture Studies—“Limit of detection of the minor component” on page 104

Because most of the kit components (for example, the master mix) remain
unchanged, we did not repeat the remaining validation experiments.

Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance
of this kit is supported when used according to the following developmentally
validated parameters. Modifications to the protocol should be accompanied by
appropriate validation studies performed by the laboratory.

Developmental validation

Developmental validation studies were performed using the ProFlex™ 96-well PCR
System, Veriti" 96-Well Thermal Cycler, and the GeneAmp™ PCR System 9700 96-
Well thermal cycler according to the protocol described in the Perform PCR chapter.

SWGDAM guideline 2.2.1

“Developmental validation is the acquisition of test data and determination of
conditions and limitations of a new or novel DNA methodology for use on forensic,
database, known or casework reference samples.” (SWGDAM, December 2016)

SWGDAM guideline 3.9.2

“The reaction conditions needed to provide the required degree of specificity

and robustness should be determined. These include, but are not limited to,

thermal cycling parameters, the concentration of primers, magnesium chloride, DNA
polymerase, and other critical reagents.” (SWGDAM, December 2016)
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SWGDAM guideline 3.9.6

“Criteria for detection of amplified product should be determined based on the
platform and/or method. ” (SWGDAM, December 2016)

PCR components

We examined the concentration of each component of the kit. The concentration

of each component was in the range where data indicated that the amplification
met the required performance criteria for specificity, sensitivity, and reproducibility.
For example, 0.5 ng of DNA Control 007 was amplified in the presence of varying
concentrations of magnesium sulfate, and the results were analyzed on a 3500xL
Genetic Analyzer (Figure 11). The performance of the multiplex is most robust within
+20% of the optimal magnesium sulfate concentration.
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Figure 11 DNA Control 007 (0.5 ng) amplified with the VeriFiler" Plus kit in the
presence of varying concentrations of magnesium sulfate and analyzed on a 3500xL
Genetic Analyzer (Y-axis scale 0-25,000 RFU) (updated formulation)

Thermal cycling temperatures

62

Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that seeks to identify the combination of temperatures and hold times that
produce the best assay performance. Optimal assay performance was determined
through evaluation of several factors, such as assay sensitivity, peak-height balance,
and resistance to PCR inhibitors.

For example, annealing/extension temperatures of 57, 58, 59, 60, and 61°C were
tested using a ProFlex™ PCR System (Figure 12). The PCR products were analyzed
using a 3500xL Genetic Analyzer.
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Developmental validation

Robust profiles were obtained between 57-61°C. The optimal combination of
specificity, sensitivity, and resistance to PCR inhibition was observed at 59°C.
Thermal cycler temperature is critical to assay performance; therefore routine,
regularly scheduled thermal cycler calibration is recommended.
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Figure 12 VeriFiler” Plus kit electropherograms obtained from amplification of 0.5 ng
of DNA Control 007 at annealing temperatures of 57, 58, 59, 60, and 61°C, analyzed on
a 3500xL Genetic Analyzer (Y-axis scale 0-25,000 RFU)

PCR cycle number

Reactions were amplified for 27, 28, 29, 30, and 31 cycles on the ProFlex™ PCR
System using 0.5 ng of DNA Control 007. As expected, the amount of PCR product
increased with the number of cycles. A full profile was generated for all numbers of
thermal cycles (27-31) and off-scale data were collected for several allele peaks at
31 cycles (Figure 13).

Additional experiments were performed not only to optimize for peak heights, peak
balance, sensitivity, and so on, but also to minimize the formation of non-target PCR
artifacts. The optimized end result is a "touchdown" PCR protocol in which the first
two cycles are performed at a slightly higher, more stringent annealing temperature
(62°C), followed by 27 cycles with an annealing temperature of 59°C.
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Figure 13 Representative VeriFiler" Plus kit profiles obtained from amplification of
0.5 ng of DNA Control 007 using 27, 28, 29, 30, and 31 cycles, analyzed on a 3500xL
Genetic Analyzer (Y-axis scale 0-35,000 RFU)

P

Accuracy, precision, and reproducibility

SWGDAM guideline 3.5

“Precision and accuracy of the assay should be demonstrated: Precision
characterizes the degree of mutual agreement among a series of individual
measurements, values and/or results. Precision depends only on the distribution of
random errors and does not relate to the true value or specified value. The measure
of precision is usually expressed in terms of imprecision and computed as a standard
deviation of the test results. Accuracy is the degree of conformity of a measured
quantity to its actual (true) value. Accuracy of a measuring instrument is the ability

of a measuring instrument to give responses close to a true value.” (SWGDAM,
December 2016)
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The accuracy and reproducibility of STR profiles have been determined from various
sample types. Important factors include: Sizing accuracy and precision, and the
consistency in observed sizing between sample STR alleles and corresponding allelic

ladder alleles.

Figure 14, Figure 15, and Figure 16 show the size differences that were observed
between sample alleles and allelic ladder alleles on the 3130x/, 3500, and 3500xL
Genetic Analyzers with POP-4™ Polymer. The X-axis in the following figures
represents the nominal nucleotide sizes for the VeriFiler" Plus Allelic Ladder. The
horizontal lines parallel to the X-axis represent the +0.25-nt windows. The Y-axis
represents the deviation of each sample allele size from the corresponding Allelic
Ladder allele size. All sample alleles are within +0.5 nt from a corresponding allele in
the Allelic Ladder, irrespective of the capillary electrophoresis platforms.

Note: The IQCS and IQCL markers were omitted from this study because they are
not used for genotyping.
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Figure 14 Allele size vs. Allelic Ladder sizing for 84 samples analyzed on a 3130x/
Genetic Analyzer. Size and ladder sizing for the VeriFiler" Plus kit were calculated
using the GeneScan™ 600 LIZ" Size Standard v2.0.
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Figure 15 Allele size vs. Allelic Ladder sizing for 84 samples analyzed on a 3500
Genetic Analyzer. Size and ladder sizing for the VeriFiler" Plus kit were calculated
using the GeneScan™ 600 LIZ" Size Standard v2.0.
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Figure 16 Allele size vs. Allelic Ladder sizing for 84 samples analyzed on a 3500xL
Genetic Analyzer. Size and ladder sizing for the VeriFiler" Plus kit were calculated
using the GeneScan" 600 LIZ" Size Standard v2.0.
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Precision and size window description

Sizing precision enables the determination of accurate and reliable genotypes. The
recommended method for genotyping is to use a +0.5-nt “window” around the size
obtained for each allele in the allelic ladder. A +0.5-nt window allows for the detection
and correct assignment of alleles. Any sample allele that sizes outside the specified
window could be either:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
allelic ladder.

* An allele that does correspond to an allele in the allelic ladder, but whose size is
just outside a window because of measurement error.

The measurement error inherent in any sizing method can be defined by the degree
of precision in sizing an allele multiple times. Precision is measured by calculating
the standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

Precision and size window observation

Table 7 lists typical precision results obtained from multiple runs of the VeriFiler" Plus
Allelic Ladder using the GeneScan™ 600 LIZ™ Size Standard v2.0. The results were
obtained within a set of injections on a single capillary array. The number of repeated
injections for each genetic analyzer is shown in Table 6.

Table 6 Number of repeated injections for each genetic analyzer

Genetic analyzer Capillaries ETS;?;i: Sizing method
3130x/ 16/injection 5 Local Southern, 60-460 bp
3500 8/injection 12 Local Southern, 60-460 bp
3500xL 24/injection 4 Local Southern, 60-460 bp

The mean sizes and the standard deviation for the allele sizing were calculated for all
the alleles in each run (Table 7). The mean range and the standard deviation range
show the lowest and highest values obtained across multiple runs.

Sample alleles can occasionally size outside of the +0.5-nt window for a respective
Allelic Ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems with the smallest standard deviations in
sizing. The figures in “Accuracy observation” on page 65 illustrate the tight clustering
of allele sizes obtained on the Applied Biosystems™ genetic analyzers, where the
standard deviation in sizing is typically less than 0.15 nt. The instance of a sample
allele sizing outside the +0.5-nt window because of measurement error is relatively
rare when the standard deviation in sizing is approximately 0.15 nt or less (Smith,
1995).
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Table 7 Precision results of multiple runs of the VeriFiler" Plus Allelic Ladder

For sample alleles that do not size within a +0.5-nt window, the PCR product must
be rerun to distinguish between a true off-ladder allele versus measurement error of
a sample allele that corresponds to an allele in the Allelic Ladder. Repeat analysis,
when necessary, provides an added level of confidence in the final allele assignment.

The GeneMapper™ ID-X Software automatically flags sample alleles that do not size
within the prescribed window around an allelic ladder allele by labeling the allele as
OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross—platform sizing differences occur due to several factors including type and
concentration of polymer, run temperature, and electrophoresis conditions. Variations
in sizing can also occur between runs on the same instrument and between runs on
different instruments of the same platform type because of these factors.

IMPORTANT! To minimize the variation in sizing between runs and to ensure
accurate genotyping, follow the guidelines in “Allelic ladder requirements for data
analysis” on page 36 and use allelic ladders obtained from the same run as samples
to analyze the samples.

For more information on precision and genotyping, see (Lazaruk et al., 1998;

Mansfield et al., 1998).

Note: The IQCS and IQCL markers were omitted from this study because they are
not used for genotyping.

3130x/ 3500 3500xL
Marker/allele Standard Standard Standard
Mean deviation Mean deviation Mean deviation
D3S1358
9 89.28-89.33 0.013-0.046 89.48-89.52 0.006-0.039 89.37-89.44 0.010-0.045
10 93.45-93.52 | 0.012-0.039 | 93.67-93.70 | 0.005-0.046 | 93.55-93.63 | 0.013-0.039
11 97.62-97.69 0.012-0.042 97.83-97.89 0.006-0.042 97.75-97.79 0.008-0.054
12 101.78-101.86 | 0.018-0.040 | 102.00-102.06 | 0.010-0.040 |101.91-101.96| 0.010-0.043
13 105.95-105.99 | 0.014-0.041 |106.13-106.20 | 0.010-0.040 |106.04-106.11| 0.008-0.034
14 110.07-110.13 | 0.014-0.043 | 110.28-110.34 | 0.013-0.038 | 110.19-110.26 | 0.010-0.040
15 114.21-114.26 | 0.017-0.039 |114.41-114.46 | 0.010-0.039 |114.33-114.38 | 0.005-0.033
16 118.33-118.38 | 0.016-0.042 | 118.53-118.58 | 0.005-0.036 | 118.45-118.51 | 0.008-0.043
17 122.45-122.51 | 0.015-0.050 |122.66-122.70 | 0.006-0.038 |122.57-122.63 | 0.013-0.050
18 126.64-126.70 | 0.010-0.041 | 126.85-126.90  0.010-0.044 | 126.76-126.83 | 0.005-0.041
19 130.73-130.78 | 0.016-0.037 | 130.92-130.97 | 0.013-0.044 | 130.84-130.89 | 0.008-0.044
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
20 134.72-134.80 | 0.008-0.036 | 134.93-134.98 | 0.013-0.043 | 134.83-134.91 | 0.006-0.044
VWA
11 151.38-151.45| 0.015-0.052 | 151.76-151.80 | 0.010-0.045 |151.65-151.76 | 0.019-0.048
12 155.39-155.45 | 0.021-0.048 | 155.78-155.83 | 0.005-0.044 | 155.69-155.77 | 0.010-0.049
13 159.46-159.52 | 0.018-0.049 | 159.85-159.90 | 0.010-0.037 | 159.76-159.83 | 0.008-0.045
14 163.68-163.74 | 0.024-0.055 |164.07-164.12 | 0.010-0.041 | 163.97-164.05| 0.010-0.053
15 167.62-167.69 | 0.026-0.047 | 168.01-168.06 | 0.010-0.045 | 167.93-168.00 | 0.010-0.050
16 171.66-171.73 | 0.021-0.049 |172.05-172.11 | 0.010-0.050 |171.98-172.06 | 0.010-0.059
17 175.71-175.77 | 0.017-0.053 |176.10-176.15| 0.005-0.046 |176.05-176.10| 0.013-0.047
18 179.72-179.77 | 0.014-0.054 |180.10-180.18 | 0.005-0.034 | 180.03-180.11 | 0.013-0.060
19 183.76-183.83 | 0.029-0.054 | 184.16-184.22 | 0.008-0.046 |184.12-184.17 | 0.000-0.057
20 187.79-187.87 | 0.028-0.054 | 188.20-188.26 | 0.005-0.056 | 188.12-188.21| 0.015-0.057
21 191.80-191.86 | 0.023-0.048 | 192.20-192.26 | 0.005-0.040 |192.13-192.21 | 0.013-0.067
22 195.83-195.88 | 0.021-0.055 | 196.23-196.29 | 0.006-0.051 | 196.14-196.24 | 0.013-0.051
23 199.77-199.84 | 0.027-0.048 | 200.20-200.25 | 0.010-0.046 |200.12-200.19 | 0.010-0.062
24 204.14-204.20 | 0.027-0.058 | 204.54-204.60 | 0.013-0.049 |204.48-204.53 | 0.013-0.057
D16S539
5 226.98-227.05 | 0.029-0.055 | 227.54-227.60 | 0.008-0.043 |227.44-227.50 | 0.029-0.077
8 239.10-239.18 | 0.037-0.067 |239.67-239.73 | 0.013-0.043 |239.59-239.64 | 0.034-0.079
9 243.17-243.24 | 0.029-0.070 |243.73-243.79 | 0.000-0.046 |243.60-243.70 | 0.025-0.090
10 247.21-247.27 | 0.041-0.078 | 247.77-247.83 | 0.013-0.050 |247.67-247.75| 0.017-0.068
11 251.26-251.33 | 0.025-0.066 |251.84-251.87 | 0.010-0.045 |251.72-251.80 | 0.026-0.081
12 255.30-255.36 | 0.043-0.061 | 255.88-255.93 | 0.015-0.045 |255.76-255.83 | 0.029-0.075
13 259.33-259.39 | 0.040-0.074 |259.92-259.98 | 0.008-0.053 |259.81-259.88 | 0.017-0.088
14 263.39-263.45 | 0.038-0.077 | 263.96-264.02 | 0.008-0.057 |263.86-263.94 | 0.021-0.077
15 267.42-267.48 | 0.037-0.077 | 268.01-268.07 | 0.005-0.056 |267.89-267.99 | 0.025-0.094
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
CSF1PO
6 281.95-282.03 | 0.035-0.077 | 282.56-282.63 | 0.010-0.057 |282.49-282.58 | 0.029-0.107
7 285.99-286.07 | 0.042-0.076 |286.58-286.65  0.016-0.045 |286.53-286.61| 0.024-0.099
8 290.02-290.10 | 0.047-0.068 |290.61-290.69 | 0.016-0.047 |290.57-290.65| 0.021-0.090
9 294.04-294.13 | 0.042-0.071 | 294.65-294.72 | 0.008-0.042 |294.60-294.69 | 0.027-0.104
10 298.07-298.15 | 0.039-0.069 |298.68-298.75| 0.010-0.050 |298.65-298.73 | 0.028-0.087
11 302.10-302.18 | 0.033-0.074 |302.72-302.79 | 0.006-0.059 |302.66-302.75| 0.040-0.081
12 306.12-306.20 | 0.032-0.075 |306.77-306.83 | 0.013-0.061 |306.72-306.79 | 0.029-0.093
13 310.15-310.23 | 0.042-0.069 |310.78-310.85| 0.013-0.054 |310.76-310.83 | 0.024-0.095
14 314.17-314.27 | 0.045-0.081 |314.83-314.89 | 0.013-0.051 |314.78-314.87 | 0.033-0.091
15 318.19-318.28 | 0.021-0.072 |318.85-318.93 | 0.010-0.065 |318.84-318.91| 0.033-0.085
D6S1043
7 334.73-334.82 | 0.029-0.074 | 335.38-335.44 | 0.006-0.055 |335.32-335.38 | 0.024-0.074
8 338.78-338.87 | 0.028-0.067 | 339.43-339.48 | 0.008-0.055 |339.37-339.45| 0.028-0.097
9 342.72-342.83 | 0.023-0.079 | 343.42-343.48 | 0.008-0.059 |343.32-343.42 | 0.029-0.087
10 346.78-346.87 | 0.027-0.071 | 347.46-347.52 | 0.008-0.054 |347.40-347.48  0.021-0.083
11 350.84-350.93 | 0.035-0.072 | 351.52-351.57 | 0.000-0.049 |351.46-351.54 | 0.025-0.079
12 354.84-354.94 | 0.047-0.069 | 355.53-355.61 | 0.006-0.062 |355.47-355.56 | 0.029-0.076
13 358.88-358.97 | 0.049-0.085 |359.57-359.62 | 0.008-0.059 |359.47-359.57 | 0.013-0.081
14 362.92-363.01 | 0.041-0.083 | 363.61-363.66 | 0.014-0.060 |363.53-363.61| 0.013-0.076
15 366.91-367.02 | 0.037-0.069 | 367.63-367.69 | 0.013-0.067 |367.55-367.63 | 0.021-0.085
16 370.90-370.99 | 0.042-0.065 |371.60-371.65| 0.010-0.057 |371.51-371.60| 0.037-0.083
17 374.91-374.99 | 0.039-0.062 |375.63-375.69 | 0.013-0.060 |375.55-375.63 | 0.019-0.096
18 378.89-378.98 | 0.026-0.066 |379.63-379.70 | 0.010-0.061 |379.55-379.63 | 0.008-0.089
19 382.92-382.99 | 0.030-0.088 | 383.67-383.73 | 0.008-0.051 |383.58-383.67 | 0.018-0.074
20 386.92-386.99 | 0.028-0.075 | 387.69-387.76 | 0.010-0.061 |387.60-387.69 | 0.026-0.098
21 390.90-390.99 | 0.029-0.082 |391.71-391.76 | 0.006-0.050 |391.62-391.69 | 0.034-0.091
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
22 394.88-394.95 | 0.021-0.070 | 395.70-395.76 | 0.015-0.066 |395.57-395.68 | 0.024-0.081
23 398.85-398.93 | 0.024-0.082 | 399.68-399.74 | 0.008-0.051 |399.57-399.68 | 0.029-0.081
24 402.82-402.91 | 0.034-0.088 | 403.70-403.74 | 0.010-0.057 |403.60-403.67 | 0.027-0.098
25 406.80-406.89 | 0.035-0.082 | 407.68-407.75 | 0.013-0.053 |407.57-407.68 | 0.030-0.085
Y Indel
1 81.20-81.26 0.019-0.047 81.43-81.47 0.005-0.051 81.33-81.38 0.008-0.036
2 86.50-86.56 | 0.023-0.041 86.73-86.78 | 0.008-0.045 86.62-86.70 | 0.010-0.042
AMEL
X 102.45-102.50 | 0.014-0.044 | 102.53-102.57 | 0.008-0.034 |102.44-102.50 | 0.013-0.041
Y 108.41-108.46 | 0.016-0.047 | 108.52-108.60 | 0.013-0.032 | 108.47-108.52 | 0.008-0.042
D8S1179
5 114.53-114.58 | 0.019-0.035 | 114.64-114.68 | 0.008-0.038 |114.57-114.62 | 0.005-0.054
6 118.63-118.69 | 0.014-0.052 | 118.74-118.79 | 0.005-0.039 |118.67-118.74 | 0.006-0.044
7 122.74-122.79 | 0.009-0.040 |122.84-122.89 | 0.006-0.046 |122.75-122.83 | 0.010-0.047
8 126.84-126.89 | 0.009-0.039 | 126.94-126.99 | 0.010-0.047 | 126.88-126.93 | 0.005-0.045
9 130.93-131.00 | 0.008-0.045 | 131.03-131.08 | 0.010-0.040 | 130.97-131.05| 0.010-0.042
10 135.02-135.08 | 0.014-0.041 | 135.12-135.16 | 0.010-0.047 | 135.04-135.11| 0.005-0.061
11 139.11-139.16 | 0.012-0.047 | 139.19-139.24 | 0.008-0.058 | 139.13-139.18 | 0.000-0.048
12 143.20-143.27 | 0.015-0.039 | 143.29-143.34 | 0.013-0.040 |143.23-143.29 | 0.013-0.047
13 147.39-147.44 | 0.012-0.035 | 147.47-147.51 | 0.010-0.039 | 147.40-147.47 | 0.008-0.052
14 151.47-151.53 | 0.016-0.046 | 151.52-151.58 | 0.006-0.039 | 151.48-151.54 | 0.010-0.054
15 155.54-155.59 | 0.010-0.037 | 155.58-155.64 | 0.005-0.039 | 155.54-155.60 | 0.010-0.048
16 159.61-159.65 | 0.016-0.032 | 159.65-159.71 | 0.010-0.048 | 159.58-159.65| 0.010-0.046
17 163.66-163.72 | 0.010-0.032 | 163.70-163.75 | 0.010-0.041 | 163.66-163.71 | 0.006-0.059
18 167.73-167.78 | 0.015-0.035 | 167.76-167.82 | 0.013-0.047 |167.72-167.76 | 0.010-0.045
19 171.79-171.86 | 0.008-0.027 |171.82-171.86| 0.010-0.044 |171.77-171.83 | 0.010-0.051
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
D21S11
24 182.85-182.91 | 0.033-0.079 | 183.23-183.28 | 0.006-0.049 | 183.17-183.25| 0.005-0.070
24 184.88-184.94 | 0.028-0.061 | 185.26-185.31 | 0.008-0.056 | 185.23-185.28 | 0.013-0.071
25 186.88-186.95 | 0.037-0.068 | 187.28-187.32 | 0.005-0.056 | 187.23-187.28 | 0.019-0.062
26 190.94-190.98 | 0.034-0.076 | 191.32-191.37 | 0.008-0.044 |191.27-191.33 | 0.017-0.072
27 194.98-195.04 | 0.042-0.065 | 195.38-195.42 | 0.008-0.047 |195.31-195.40| 0.014-0.077
28 198.99-199.05 | 0.035-0.077 | 199.37-199.43 | 0.010-0.044 | 199.34-199.40| 0.013-0.067
28 200.99-201.03 | 0.039-0.061 |201.38-201.43 | 0.010-0.045 |201.34-201.39 | 0.008-0.074
29 203.00-203.05 | 0.045-0.077 |203.39-203.44 | 0.008-0.052 |203.37-203.42 | 0.005-0.067
29 205.06-205.10 | 0.042-0.079 | 205.44-205.50 | 0.015-0.047 |205.40-205.47 | 0.021-0.078
30 207.05-207.10 | 0.039-0.074 | 207.45-207.51| 0.013-0.045 |207.39-207.47 | 0.017-0.082
30 209.05-209.11 | 0.042-0.072 |209.45-209.49 | 0.010-0.043 |209.39-209.47 | 0.021-0.067
31 211.08-211.14 | 0.032-0.067 |211.49-211.55| 0.008-0.045 |211.43-211.51 | 0.010-0.072
31 213.08-213.15| 0.039-0.073 |213.49-213.52 | 0.010-0.043 |213.44-213.50 | 0.014-0.081
32 215.12-215.17 | 0.042-0.074 | 215.52-215.57 | 0.005-0.040 |215.47-215.54 | 0.010-0.069
32 217.10-217.16 | 0.050-0.069 |217.52-217.56 | 0.005-0.048 |217.44-217.54 | 0.010-0.069
33 219.14-219.22 | 0.048-0.075 |219.55-219.61 | 0.006-0.039 |219.52-219.59 | 0.017-0.080
33 221.10-221.16 | 0.044-0.071 | 221.50-221.57 | 0.010-0.050 |221.48-221.54 | 0.020-0.085
34 223.23-223.29 | 0.035-0.078 |223.65-223.69 | 0.013-0.040 |223.59-223.66 | 0.022-0.075
34 225.17-225.23 | 0.043-0.074 | 225.58-225.64 | 0.010-0.042 |225.54-225.61 | 0.021-0.090
35 227.26-227.30 | 0.030-0.080 |227.66-227.71 | 0.005-0.046 |227.62-227.68 | 0.024-0.077
35 229.20-229.25 | 0.042-0.073 | 229.61-229.67 | 0.005-0.048 |229.57-229.64 | 0.022-0.076
36 231.20-231.26 | 0.037-0.082 |231.63-231.69 | 0.010-0.051 |231.58-231.65| 0.017-0.075
37 235.28-235.34 | 0.042-0.076 |235.71-235.75 | 0.006-0.051 |235.65-235.73 | 0.030-0.070
38 239.25-239.32 | 0.040-0.082 | 239.67-239.75| 0.008-0.045 |239.62-239.71 | 0.028-0.072
D18S51
7 261.02-261.08 | 0.037-0.075 |261.35-261.42 | 0.005-0.044 |261.32-261.38 | 0.037-0.064
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
9 269.17-269.23 | 0.028-0.068 | 269.49-269.56 | 0.010-0.051 |269.44-269.51 | 0.010-0.068
10 273.24-273.30 | 0.034-0.062 |273.56-273.62 | 0.013-0.045 |273.52-273.59 | 0.013-0.071
10 275.24-275.30 | 0.034-0.079 |275.56-275.61| 0.010-0.041 |275.51-275.60 | 0.024-0.060
11 277.31-277.37 | 0.025-0.063 |277.63-277.69 | 0.010-0.046 |277.58-277.65| 0.015-0.062
12 281.38-281.45| 0.031-0.073 | 281.70-281.75| 0.008-0.056 |281.64-281.72 | 0.015-0.078
13 285.46-285.53 | 0.037-0.069 | 285.77-285.81 | 0.010-0.051 |285.69-285.79 | 0.016-0.063
13 287.48-287.54 | 0.027-0.075 |287.77-287.82| 0.017-0.051 |287.71-287.79 | 0.010-0.062
14 289.53-289.60 | 0.034-0.058 |289.82-289.89 | 0.013-0.044 |289.80-289.87 | 0.013-0.068
14 291.56-291.61 | 0.032-0.069 |291.82-291.89 | 0.013-0.051 |291.79-291.85| 0.005-0.070
15 293.62-293.68 | 0.020-0.057 | 293.91-293.96 | 0.008-0.046 |293.85-293.93 | 0.010-0.064
16 297.70-297.77 | 0.035-0.064 |297.97-298.03 | 0.010-0.059 |297.92-298.00 | 0.010-0.059
17 301.76-301.83 | 0.029-0.071 |302.03-302.09 | 0.017-0.051 |302.01-302.08 | 0.019-0.062
18 305.85-305.90 | 0.025-0.078 | 306.11-306.18 | 0.010-0.055 |306.08-306.14 | 0.021-0.053
19 309.94-309.98 | 0.029-0.061 |310.16-310.22 | 0.016-0.051 |310.15-310.21 | 0.008-0.067
20 314.00-314.06 | 0.021-0.054 |314.25-314.29 | 0.013-0.045 |314.21-314.28 | 0.010-0.059
21 318.10-318.13 | 0.021-0.057 |318.31-318.37 | 0.010-0.043 |318.26-318.37 | 0.008-0.054
22 322.22-322.28 | 0.015-0.055 | 322.44-322.50 | 0.005-0.053 |322.42-322.49 | 0.010-0.062
23 326.22-326.28 | 0.025-0.064 | 326.43-326.51 | 0.013-0.057 | 326.42-326.49 | 0.015-0.076
24 330.27-330.34 | 0.022-0.067 |330.51-330.56 | 0.010-0.041 |330.49-330.57 | 0.013-0.073
25 334.34-334.41 | 0.018-0.062 | 334.56-334.63 | 0.008-0.056 |334.56-334.63 | 0.010-0.059
26 338.44-338.49 | 0.022-0.055 | 338.63-338.69 | 0.005-0.050 |338.63-338.72 | 0.010-0.055
27 342.48-342.56 | 0.024-0.068 | 342.71-342.76 | 0.006-0.052 |342.72-342.79 | 0.014-0.059
D5S818
7 370.14-370.21 | 0.037-0.079 |370.66-370.71 | 0.015-0.068 |370.60-370.70 | 0.006-0.077
8 374.15-374.21 | 0.029-0.059 |374.68-374.75| 0.010-0.064 |374.65-374.73 | 0.013-0.079
9 378.14-378.20 | 0.019-0.063 | 378.71-378.76 | 0.010-0.074 | 378.67-378.75| 0.018-0.076
10 382.14-382.20 | 0.016-0.068 |382.71-382.79 | 0.010-0.065 |382.69-382.77 | 0.013-0.076
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
11 386.13-386.20 | 0.024-0.072 | 386.74-386.80 | 0.008-0.057 |386.71-386.78 | 0.024-0.090
12 390.12-390.19 | 0.037-0.072 | 390.75-390.82 | 0.013-0.061 |390.73-390.80 | 0.021-0.082
13 394.10-394.18 | 0.038-0.102 | 394.76-394.83 | 0.015-0.067 |394.72-394.82 | 0.032-0.087
14 398.10-398.16 | 0.032-0.071 |398.77-398.82 | 0.010-0.068 |398.74-398.82 | 0.031-0.091
15 402.08-402.14 | 0.026-0.073 | 402.77-402.84 | 0.012-0.058 |402.73-402.81 | 0.017-0.095
16 406.06-406.12 | 0.032-0.110 | 406.78-406.85| 0.013-0.075 |406.73-406.81 | 0.017-0.085
17 410.04-410.10 | 0.044-0.114 |410.78-410.85| 0.008-0.079 |410.72-410.82 | 0.021-0.100
18 414.00-414.08 | 0.043-0.103 |414.77-414.85| 0.017-0.057 |414.73-414.80| 0.037-0.106
D2S441
8 83.24-83.27 0.008-0.034 83.25-83.30 0.005-0.050 83.19-83.25 0.005-0.036
9 87.34-87.37 | 0.012-0.031 87.37-87.42 | 0.006-0.038 | 87.31-87.40 | 0.008-0.036
10 91.40-91.42 | 0.010-0.034 | 91.45-91.50 | 0.005-0.041 91.40-91.45 | 0.008-0.035
11 95.52-95.56 0.014-0.046 95.60-95.65 0.006-0.046 95.56-95.61 0.013-0.038
11 98.49-98.53 0.015-0.032 98.57-98.63 0.008-0.039 98.54-98.58 0.008-0.048
12 99.59-99.64 | 0.015-0.037 | 99.69-99.73 | 0.008-0.041 99.65-99.70 | 0.008-0.035
13 103.52-103.55 | 0.018-0.036 | 103.62-103.68 | 0.013-0.036 | 103.58-103.64 | 0.013-0.045
14 107.59-107.63 | 0.015-0.049 |107.71-107.76 | 0.014-0.038 |107.67-107.71 | 0.008-0.046
15 111.64-111.69 | 0.015-0.045 |111.78-111.82 | 0.014-0.045 |111.75-111.80| 0.006-0.039
16 115.73-115.78 | 0.010-0.033 | 115.85-115.90 | 0.010-0.034 |115.81-115.89 | 0.010-0.044
17 119.88-119.93 | 0.014-0.033 | 120.02-120.07 | 0.013-0.045 |120.01-120.05| 0.013-0.039
D19S433
5 141.04-141.09 | 0.016-0.043 | 141.42-141.46 | 0.006-0.050 |141.37-141.44| 0.021-0.059
6 145.02-145.07 | 0.019-0.059 | 145.41-145.45| 0.008-0.038 | 145.39-145.45| 0.013-0.071
7 148.99-149.05 | 0.015-0.048 | 149.39-149.44 | 0.014-0.051 | 149.38-149.44| 0.010-0.063
8 152.95-153.02 | 0.014-0.056 | 153.38-153.42 | 0.010-0.046 | 153.33-153.42 | 0.018-0.069
9 156.91-156.98 | 0.026-0.055 | 157.35-157.41 | 0.008-0.042 | 157.35-157.40| 0.014-0.073
10 160.86-160.94 | 0.029-0.051 | 161.33-161.38 | 0.010-0.041 | 161.32-161.38 | 0.013-0.065
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
11 164.82-164.89 | 0.017-0.048 | 165.30-165.36 | 0.010-0.052 | 165.28-165.36| 0.017-0.070
12 168.78-168.85 | 0.029-0.054 | 169.26-169.32 | 0.008-0.052 | 169.24-169.33 | 0.024-0.084
12 170.89-170.97 | 0.032-0.059 |171.38-171.44 | 0.006-0.046 |171.37-171.45| 0.005-0.076
13 172.74-172.81 | 0.018-0.060 |173.24-173.29 | 0.005-0.048 |173.22-173.30| 0.027-0.080
13 174.72-174.80 | 0.025-0.062 |175.22-175.28 | 0.010-0.045 |175.21-175.30| 0.027-0.079
14 176.68-176.76 | 0.030-0.065 |177.20-177.26 | 0.008-0.054 |177.16-177.27 | 0.028-0.082
14 178.65-178.74 | 0.026-0.069 |179.17-179.25| 0.005-0.037 |179.16-179.27 | 0.018-0.088
15 180.62-180.70 | 0.029-0.070 |181.14-181.21 | 0.005-0.039 |181.11-181.23 | 0.024-0.098
15 182.63-182.69 | 0.028-0.064 | 183.15-183.22 | 0.006-0.046 | 183.15-183.22 | 0.028-0.088
16 184.56-184.66 | 0.034-0.060 | 185.10-185.17 | 0.006-0.046 | 185.07-185.19 | 0.031-0.077
16 186.57-186.66 | 0.028-0.063 | 187.11-187.17 | 0.005-0.043 | 187.13-187.20| 0.029-0.083
17 188.49-188.59 | 0.028-0.070 | 189.06-189.13 | 0.005-0.053 | 189.05-189.15| 0.032-0.087
17 190.53-190.62 | 0.031-0.064 | 191.09-191.15| 0.005-0.062 |191.07-191.16| 0.030-0.096
18 194.56-194.64 | 0.032-0.060 | 195.12-195.19 | 0.008-0.032 | 195.12-195.20 | 0.037-0.077
19 198.49-198.58 | 0.031-0.062 | 199.08-199.14 | 0.010-0.051 | 199.08-199.17 | 0.028-0.105
FGA
13 207.89-207.92 | 0.012-0.039 | 207.88-207.93 | 0.008-0.052 |207.83-207.89 | 0.010-0.042
14 211.94-211.97 | 0.013-0.030 |211.93-211.97 | 0.010-0.051 |211.88-211.94 | 0.013-0.055
15 215.99-216.02 | 0.011-0.035 |215.96-216.02 | 0.008-0.051 |215.93-215.97 | 0.005-0.049
16 220.05-220.09 | 0.016-0.032 | 220.01-220.07 | 0.008-0.047 |219.97-220.04 | 0.010-0.046
17 224.11-224.15| 0.015-0.039 | 224.05-224.11 | 0.010-0.043 |224.01-224.08 | 0.010-0.040
18 228.16-228.20 | 0.013-0.031 |228.11-228.17 | 0.006-0.053 |228.07-228.12 | 0.005-0.049
19 232.22-232.27 | 0.013-0.033 | 232.15-232.20 | 0.010-0.042 |232.12-232.17 | 0.010-0.048
20 236.27-236.33 | 0.010-0.041 | 236.20-236.25 | 0.010-0.046 |236.17-236.22 | 0.005-0.043
21 240.33-240.38 | 0.008-0.052 |240.25-240.30 | 0.010-0.045 |240.21-240.27 | 0.006-0.039
22 244.39-244.44 | 0.012-0.034 | 244.30-244.35| 0.000-0.045 |244.25-244.33 | 0.012-0.041
23 248.46-248.50 | 0.012-0.044 | 248.34-248.40| 0.013-0.038 |248.31-248.36 | 0.008-0.050
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
24 252.51-252.56 | 0.014-0.040 |252.39-252.45| 0.010-0.046 |252.38-252.43 | 0.010-0.044
25 256.58-256.62 | 0.016-0.033 | 256.46-256.51 | 0.014-0.044 |256.41-256.49 | 0.010-0.042
26 260.63-260.68 | 0.014-0.046 | 260.48-260.54 | 0.005-0.052 |260.46-260.52 | 0.010-0.050
26 262.66-262.71 | 0.014-0.063 | 262.53-262.59 | 0.010-0.050 |262.49-262.55 | 0.005-0.041
27 264.66-264.70 | 0.012-0.040 | 264.52-264.56 | 0.010-0.041 |264.48-264.53 | 0.010-0.048
28 268.72-268.76 | 0.010-0.046 | 268.58-268.61 | 0.010-0.048 |268.53-268.59 | 0.008-0.045
29 272.78-272.83 | 0.017-0.063 | 272.63-272.69 | 0.013-0.038 |272.61-272.66 | 0.005-0.049
30 276.86-276.92 | 0.011-0.048 | 276.71-276.78 | 0.008-0.045 |276.68-276.73 | 0.006-0.045
30 278.69-278.75 | 0.012-0.044 | 278.55-278.60 | 0.010-0.053 |278.51-278.58 | 0.006-0.048
31 282.76-282.81 | 0.012-0.034 | 282.59-282.67 | 0.008-0.045 |282.55-282.63 | 0.008-0.048
32 286.83-286.88 | 0.018-0.038 | 286.68-286.73 | 0.010-0.042 |286.62-286.69 | 0.013-0.051
33 290.89-290.94 | 0.014-0.036 |290.71-290.77 | 0.013-0.041 |290.67-290.75| 0.008-0.049
42 327.62-327.67 | 0.014-0.050 |327.39-327.43 | 0.010-0.053 |327.38-327.46 | 0.008-0.057
43 331.67-331.73 | 0.006-0.061 | 331.44-331.49| 0.010-0.049 |331.42-331.51| 0.015-0.063
44 335.72-335.79 | 0.015-0.046 |335.50-335.57 | 0.010-0.046 |335.53-335.59 | 0.013-0.062
45 339.80-339.86 | 0.019-0.048 |339.57-339.63 | 0.000-0.050 |339.59-339.65| 0.010-0.068
46 343.77-343.84 | 0.013-0.054 | 343.52-343.59 | 0.005-0.057 |343.54-343.61| 0.005-0.077
47 347.84-347.90 | 0.013-0.047 | 347.57-347.64 | 0.013-0.041 | 347.59-347.67 | 0.013-0.067
48 351.92-351.98 | 0.012-0.043 | 351.66-351.72 | 0.010-0.048 |351.67-351.75| 0.006-0.076
49 355.98-356.04 | 0.014-0.044 |355.71-355.77 | 0.000-0.045 |355.74-355.80| 0.012-0.060
50 360.03-360.07 | 0.018-0.054 | 359.73-359.80 | 0.013-0.050 |359.75-359.82 | 0.017-0.079
51 364.08-364.14 | 0.018-0.078 | 363.80-363.85| 0.014-0.056 |363.82-363.88 | 0.017-0.073
D10S1248
8 371.77-371.82 | 0.023-0.063 | 372.17-372.23 | 0.010-0.057 |372.12-372.21 | 0.010-0.071
9 375.73-375.80 | 0.023-0.061 |376.16-376.23 | 0.010-0.059 |376.13-376.20 | 0.017-0.069
10 379.73-379.79 | 0.031-0.058 | 380.16-380.23 | 0.010-0.047 |380.14-380.19 | 0.016-0.056
11 383.68-383.76 | 0.024-0.060 |384.12-384.19 | 0.008-0.054 |384.09-384.16| 0.010-0.068
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

8

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
12 387.70-387.76 | 0.020-0.056 |388.15-388.22 | 0.012-0.054 |388.13-388.18 | 0.021-0.058
13 391.69-391.75| 0.019-0.163 | 392.14-392.20 | 0.013-0.062 |392.11-392.17 | 0.010-0.072
14 395.65-395.72 | 0.028-0.088 |396.10-396.17 | 0.013-0.054 |396.07-396.15| 0.008-0.076
15 399.64-399.72 | 0.028-0.128 |400.11-400.17 | 0.013-0.054 |400.07-400.14 | 0.017-0.074
16 403.61-403.67 | 0.024-0.062 | 404.10-404.19 | 0.013-0.058 |404.07-404.14| 0.017-0.077
17 407.63-407.68 | 0.025-0.081 |408.13-408.18 | 0.005-0.057 |408.08-408.14 | 0.017-0.085
18 411.56-411.60 | 0.019-0.115 | 412.04-412.12 | 0.008-0.052 |412.00-412.09 | 0.014-0.067
19 415.49-415.57 | 0.021-0.102 | 416.02-416.10| 0.015-0.056 |416.00-416.05| 0.017-0.080
D22S1045
8 88.43-88.47 0.012-0.037 88.46-88.53 0.005-0.039 88.40-88.45 0.005-0.052
9 91.42-91.46 0.013-0.037 91.46-91.54 0.005-0.042 91.41-91.46 0.010-0.042
10 94.42-94.46 0.010-0.030 94.50-94.54 0.005-0.042 94.43-94.47 0.012-0.039
11 97.43-97.46 0.013-0.038 97.49-97.56 0.008-0.045 97.43-97.49 0.005-0.054
12 100.42-100.45 | 0.010-0.042 | 100.51-100.56 | 0.006-0.043 | 100.45-100.50 | 0.005-0.036
13 103.41-103.46 | 0.012-0.038 | 103.50-103.57 | 0.008-0.040 | 103.44-103.49 | 0.013-0.041
14 106.40-106.44 | 0.008-0.039 | 106.51-106.55 | 0.015-0.045 | 106.43-106.48 | 0.014-0.041
15 109.39-109.44 | 0.013-0.044 |109.51-109.57 | 0.013-0.039 | 109.44-109.50 | 0.010-0.043
16 112.38-112.42 | 0.017-0.038 |112.50-112.54 | 0.010-0.039 | 112.43-112.49| 0.000-0.037
17 115.37-115.40 | 0.008-0.028 |115.49-115.56 | 0.010-0.044 |115.41-115.49| 0.013-0.040
18 118.35-118.41 | 0.012-0.032 | 118.50-118.55 | 0.013-0.053 |118.41-118.48 | 0.008-0.041
19 121.34-121.40 | 0.010-0.040 |121.48-121.53 | 0.005-0.042 |121.41-121.46 | 0.006-0.042
D1S1656
9 146.83-146.86 | 0.011-0.039 | 146.87-146.93 | 0.010-0.043 | 146.86-146.91 | 0.005-0.041
10 150.72-150.76 | 0.015-0.034 | 150.77-150.83 | 0.010-0.039 | 150.78-150.81 | 0.017-0.043
11 154.72-154.77 | 0.010-0.038 | 154.78-154.83 | 0.008-0.044 |154.77-154.84 | 0.014-0.050
12 158.81-158.85 | 0.014-0.031 | 158.86-158.92 | 0.010-0.042 | 158.88-158.91 | 0.013-0.048
13 162.74-162.76 | 0.017-0.034 | 162.80-162.85| 0.014-0.037 |162.80-162.85 | 0.010-0.043
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
14 166.81-166.85 | 0.012-0.038 | 166.89-166.93 | 0.013-0.048 | 166.87-166.94 | 0.010-0.051
14 169.77-169.80 | 0.010-0.034 | 169.85-169.89 | 0.008-0.043 | 169.85-169.89 | 0.010-0.047
15 170.79-170.83 | 0.010-0.047 | 170.87-170.92 | 0.006-0.036 |170.86-170.93 | 0.000-0.051
15 173.75-173.79 | 0.014-0.035 |173.84-173.90 | 0.005-0.042 |173.83-173.89 | 0.006-0.043
16 174.80-174.85 | 0.014-0.035 |174.88-174.93 | 0.000-0.036 |174.88-174.94 | 0.008-0.053
16 177.75-177.80 | 0.016-0.040 |177.83-177.89 | 0.008-0.044 |177.84-177.89 | 0.010-0.048
17 178.88-178.92 | 0.012-0.064 | 178.95-179.00 | 0.008-0.040 | 178.95-179.00| 0.013-0.053
17 181.75-181.79 | 0.009-0.043 | 181.84-181.89 | 0.005-0.039 |181.82-181.89 | 0.014-0.044
18 182.78-182.82 | 0.010-0.034 | 182.87-182.92 | 0.005-0.050 |182.85-182.92 | 0.005-0.051
18 185.75-185.78 | 0.012-0.042 | 185.84-185.89 | 0.005-0.041 | 185.85-185.90 | 0.010-0.040
19 189.77-189.80 | 0.017-0.036 | 189.88-189.93 | 0.006-0.043 | 189.87-189.93 | 0.006-0.052
20 193.82-193.86 | 0.014-0.035 | 193.93-193.98 | 0.005-0.033 | 193.92-193.98 | 0.008-0.059
D13S317
5 201.31-201.35| 0.020-0.036 |201.46-201.52 | 0.010-0.047 |201.45-201.50 | 0.013-0.053
6 205.33-205.37 | 0.015-0.031 | 205.47-205.52 | 0.015-0.038 |205.46-205.51 | 0.005-0.045
7 209.35-209.39 | 0.011-0.039 |209.49-209.54 | 0.010-0.050 |209.48-209.53 | 0.017-0.056
8 213.37-213.42 | 0.015-0.033 |213.49-213.55| 0.005-0.039 |213.50-213.55| 0.014-0.049
9 217.42-217.46 | 0.014-0.036 |217.53-217.58 | 0.005-0.039 |217.50-217.56 | 0.005-0.048
10 221.43-221.48 | 0.019-0.036 |221.55-221.60 | 0.010-0.054 |221.53-221.60 | 0.006-0.045
11 225.48-225.50 | 0.018-0.038 | 225.58-225.63 | 0.010-0.043 |225.57-225.62 | 0.017-0.048
12 229.49-229.54 | 0.014-0.039 | 229.60-229.66 | 0.008-0.049 |229.59-229.64 | 0.010-0.043
13 233.54-233.58 | 0.012-0.044 | 233.62-233.68 | 0.008-0.043 |233.63-233.66 | 0.015-0.051
14 237.55-237.61 | 0.012-0.034 | 237.66-237.72 | 0.005-0.044 |237.64-237.69 | 0.006-0.054
15 241.59-241.64 | 0.005-0.041 |241.69-241.74 | 0.006-0.048 |241.67-241.72 | 0.010-0.053
16 245.64-245.70 | 0.015-0.043 | 245.72-245.78 | 0.008-0.042 |245.71-245.76 | 0.015-0.066
D7S820
6 259.89-259.94 | 0.010-0.048 | 260.03-260.07 | 0.008-0.049 |259.99-260.05| 0.008-0.046
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
7 263.90-263.96 | 0.008-0.045 | 264.06-264.11 | 0.013-0.042 |264.00-264.07 | 0.014-0.049
8 267.92-267.97 | 0.018-0.044 | 268.08-268.13 | 0.010-0.048 |268.05-268.09 | 0.010-0.056
9 271.95-271.99 | 0.009-0.045 |272.10-272.15| 0.017-0.045 |272.07-272.12 | 0.010-0.050
10 275.96-276.01 | 0.017-0.042 | 276.13-276.19 | 0.010-0.047 |276.10-276.16 | 0.010-0.061
11 279.97-280.02 | 0.012-0.057 |280.16-280.22 | 0.010-0.047 |280.10-280.19 | 0.014-0.052
12 284.00-284.04 | 0.017-0.042 | 284.20-284.25| 0.012-0.039 |284.14-284.21 | 0.012-0.056
13 288.02-288.08 | 0.012-0.040 |288.21-288.28 | 0.014-0.042 |288.18-288.24 | 0.008-0.061
14 292.05-292.09 | 0.013-0.045 |292.24-292.30 | 0.013-0.048 |292.21-292.27 | 0.010-0.062
15 296.07-296.11 | 0.017-0.040 |296.26-296.33 | 0.010-0.052 |296.24-296.28 | 0.010-0.053
Penta E
5 310.56-310.66 | 0.075-0.110 |311.23-311.28 | 0.010-0.059 |311.20-311.26 | 0.044-0.096
6 315.69-315.78 | 0.068-0.113 | 316.34-316.39 | 0.014-0.055 |316.30-316.38 | 0.014-0.097
7 320.72-320.82 | 0.073-0.121 | 321.41-321.47 | 0.005-0.051 |321.39-321.46 | 0.028-0.099
8 325.78-325.88 | 0.060-0.108 | 326.44-326.50 | 0.010-0.057 | 326.42-326.48 | 0.029-0.096
9 330.82-330.91 | 0.060-0.109 | 331.48-331.54 | 0.008-0.052 |331.46-331.54| 0.025-0.090
10 335.88-335.97 | 0.071-0.103 | 336.53-336.59 | 0.010-0.058 |336.53-336.60 | 0.040-0.097
11 340.87-341.01 | 0.064-0.117 | 341.58-341.66 | 0.005-0.056 |341.59-341.65| 0.040-0.094
12 345.96-346.05 | 0.078-0.118 | 346.63-346.69 | 0.013-0.070 | 346.64-346.71 | 0.036-0.081
13 351.02-351.12 | 0.065-0.120 | 351.69-351.75| 0.005-0.055 |351.70-351.78 | 0.017-0.091
14 356.06-356.18 | 0.075-0.123 | 356.74-356.80 | 0.018-0.066 |356.74-356.83 | 0.030-0.090
15 361.13-361.23 | 0.093-0.137 | 361.80-361.86| 0.013-0.055 |361.78-361.87 | 0.033-0.090
16 366.21-366.29 | 0.073-0.122 | 366.83-366.91 | 0.013-0.067 | 366.82-366.91 | 0.019-0.082
17 371.24-371.35| 0.069-0.117 |371.90-371.98 | 0.013-0.070 |371.87-371.96 | 0.021-0.080
18 376.29-376.36 | 0.066-0.116 | 376.96-377.02 | 0.019-0.068 |376.93-377.00| 0.030-0.083
19 381.31-381.41 | 0.070-0.104 | 382.00-382.07 | 0.014-0.059 |381.98-382.03 | 0.012-0.083
20 386.35-386.43 | 0.069-0.108 | 387.04-387.09 | 0.010-0.070 |387.01-387.10| 0.031-0.109
21 391.38-391.46 | 0.068-0.106 |392.07-392.15 | 0.008-0.056 |392.05-392.14| 0.005-0.087
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
22 396.39-396.48 | 0.064-0.108 |397.11-397.17 | 0.012-0.067 |397.07-397.16 | 0.017-0.095
23 401.41-401.51 | 0.071-0.111 | 402.15-402.21 | 0.010-0.054 |402.11-402.21 | 0.030-0.101
24 406.40-406.52 | 0.077-0.120 |407.17-407.23 | 0.005-0.052 |407.14-407.22 | 0.013-0.092
25 411.44-411.54 | 0.081-0.109 |412.20-412.25| 0.008-0.051 |412.16-412.24 | 0.029-0.083
26 416.45-416.52 | 0.076-0.113 | 417.22-417.27 | 0.017-0.067 |417.21-417.28 | 0.026-0.095
Penta D
2 78.64-78.68 | 0.008-0.055 78.99-79.05 | 0.010-0.048 | 78.87-78.95 | 0.010-0.061
3 83.57-83.62 | 0.013-0.057 | 83.98-84.05 | 0.005-0.049 83.86-83.94 | 0.017-0.063
5 91.30-91.35 0.023-0.053 91.78-91.86 0.010-0.037 91.65-91.74 0.018-0.062
6 96.21-96.27 0.023-0.067 96.71-96.79 0.010-0.041 96.62-96.69 0.022-0.064
7 101.32-101.37 | 0.023-0.060 |101.85-101.92 | 0.008-0.035 |101.72-101.81| 0.013-0.059
8 105.99-106.05 | 0.028-0.060 | 106.60-106.65| 0.012-0.044 | 106.47-106.57 | 0.022-0.077
9 110.88-110.96 | 0.028-0.063 |111.52-111.57 | 0.010-0.033 | 111.38-111.48 | 0.025-0.071
10 115.91-115.96 | 0.025-0.060 | 116.55-116.60 | 0.005-0.041 |116.44-116.51| 0.021-0.073
11 120.62-120.69 | 0.038-0.075 |121.30-121.38 | 0.008-0.041 |121.17-121.28 | 0.029-0.076
12 125.49-125.57 | 0.035-0.073 | 126.21-126.27 | 0.017-0.042 | 126.07-126.19 | 0.030-0.077
13 130.45-130.53 | 0.031-0.078 |131.21-131.28 | 0.010-0.038 | 131.06-131.18 | 0.031-0.081
14 135.19-135.27 | 0.033-0.077 | 135.95-136.04 | 0.008-0.049 | 135.82-135.94 | 0.029-0.094
15 140.05-140.13 | 0.038-0.073 | 140.85-140.93 | 0.010-0.043 | 140.73-140.85 | 0.039-0.092
16 145.02-145.10 | 0.046-0.077 | 145.85-145.90 | 0.008-0.042 |145.70-145.81 | 0.029-0.098
17 149.75-149.84 | 0.048-0.081 | 150.61-150.67 | 0.010-0.061 | 150.44-150.59 | 0.043-0.102
THO1
4 169.86-169.92 | 0.029-0.060 | 170.35-170.40 | 0.005-0.045 |170.30-170.38 | 0.017-0.069
5 173.87-173.94 | 0.018-0.055 |174.34-174.42 | 0.000-0.047 |174.30-174.39| 0.013-0.068
6 177.86-177.93 | 0.023-0.060 |178.36-178.41 | 0.008-0.048 |178.31-178.38 | 0.017-0.076
7 181.86-181.94 | 0.030-0.053 | 182.36-182.40 | 0.005-0.036 |182.32-182.40| 0.021-0.075
8 185.86-185.94 | 0.022-0.060 | 186.35-186.43 | 0.005-0.043 | 186.33-186.40| 0.016-0.078
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
9 189.87-189.95 | 0.035-0.059 | 190.39-190.43 | 0.008-0.051 | 190.34-190.41 | 0.024-0.076
9 192.94-193.01 | 0.028-0.069 | 193.43-193.49 | 0.010-0.050 |193.41-193.48 | 0.019-0.080
10 193.88-193.95 | 0.031-0.062 | 194.37-194.44 | 0.005-0.051 | 194.35-194.42 | 0.015-0.074
11 197.87-197.96 | 0.027-0.060 | 198.40-198.47 | 0.006-0.046 |198.37-198.44 | 0.021-0.078
12 201.89-201.97 | 0.029-0.070 |202.39-202.48 | 0.013-0.050 |202.37-202.44 | 0.034-0.071
13 208.95-209.03 | 0.036-0.065 |209.45-209.52 | 0.010-0.048 |209.43-209.52 | 0.025-0.081
D12S391
14 218.79-218.84 | 0.014-0.034 |218.81-218.88 | 0.006-0.034 |218.81-218.87 | 0.010-0.047
15 222.81-222.84 | 0.016-0.041 | 222.81-222.87 | 0.010-0.046 |222.82-222.87 | 0.012-0.042
16 226.76-226.80 | 0.010-0.033 | 226.76-226.83 | 0.012-0.050 |226.77-226.82 | 0.015-0.056
17 230.84-230.89 | 0.013-0.036 |230.84-230.90  0.008-0.054 |230.85-230.90| 0.008-0.064
18 234.88-234.92 | 0.015-0.036 |234.87-234.92 | 0.005-0.058 |234.87-234.91| 0.010-0.043
19 238.94-238.99 | 0.015-0.037 | 238.94-238.99 | 0.010-0.047 |238.92-238.98 | 0.005-0.048
19 241.95-242.00 | 0.010-0.076 |241.93-241.98 | 0.005-0.043 |241.93-241.97 | 0.010-0.055
20 242.89-242.95 | 0.012-0.043 | 242.91-242.95| 0.010-0.052 |242.89-242.95| 0.008-0.044
21 247.01-247.06 | 0.010-0.043 | 246.99-247.04 | 0.010-0.041 |246.97-247.04 | 0.005-0.046
22 251.12-251.17 | 0.012-0.038 | 251.09-251.15| 0.014-0.041 |251.08-251.13 | 0.013-0.050
23 255.12-255.18 | 0.011-0.033 | 255.10-255.15| 0.010-0.040 |255.09-255.15| 0.013-0.042
24 259.13-259.19 | 0.018-0.034 |259.11-259.16 | 0.010-0.042 |259.09-259.15| 0.010-0.033
25 263.16-263.22 | 0.017-0.035 |263.13-263.19 | 0.013-0.053 |263.12-263.18 | 0.008-0.046
26 267.23-267.27 | 0.015-0.048 | 267.19-267.23 | 0.006-0.038 |267.16-267.22 | 0.005-0.043
27 271.22-271.27 | 0.012-0.041 | 271.18-271.24 | 0.013-0.046 |271.16-271.23 | 0.010-0.045
D2S1338
11 280.86-280.95 | 0.042-0.072 |281.45-281.48 | 0.008-0.058 |281.40-281.48 | 0.040-0.085
12 284.85-284.94 | 0.031-0.069 |285.45-285.50 | 0.017-0.043 |285.41-285.48 | 0.041-0.093
13 288.87-288.94 | 0.031-0.075 | 289.42-289.51 | 0.013-0.057 |289.41-289.48 | 0.033-0.089
14 292.86-292.96 | 0.024-0.065 |293.43-293.48  0.010-0.062 |293.40-293.50 | 0.021-0.088
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Table 7 Precision results of multiple runs of the VeriFiler Plus Allelic Ladder (continued)

3130x/ 3500 3500xL
Marker/allels Standard Standard Standard
Mean deviation Mean deviation Mean deviation
15 296.82-296.91 | 0.025-0.061 | 297.35-297.39 | 0.006-0.048 |297.31-297.39 | 0.021-0.089
16 300.87-300.94 | 0.034-0.067 |301.39-301.45| 0.015-0.053 |301.37-301.44 | 0.029-0.086
17 304.87-304.94 | 0.033-0.063 | 305.40-305.46 | 0.010-0.054 |305.39-305.46 | 0.021-0.088
18 308.91-308.98 | 0.029-0.070 |309.41-309.48 | 0.014-0.053 |309.41-309.47 | 0.029-0.082
19 312.91-312.98 | 0.034-0.058 | 313.44-313.50| 0.013-0.053 |313.41-313.48 | 0.039-0.091
20 316.92-317.00 | 0.020-0.058 |317.45-317.51| 0.013-0.060 |317.43-317.49 | 0.021-0.088
21 320.97-321.05 | 0.021-0.063 | 321.48-321.54 | 0.005-0.051 |321.47-321.54 | 0.027-0.084
22 324.97-325.06 | 0.033-0.070 |325.48-325.53 | 0.010-0.053 |325.46-325.53 | 0.015-0.070
23 328.98-329.06 | 0.024-0.060 |329.49-329.55| 0.013-0.073 |329.48-329.58 | 0.015-0.088
24 333.00-333.08 | 0.024-0.061 | 333.53-333.58 | 0.010-0.054 |333.51-333.61 | 0.015-0.075
25 337.01-337.10 | 0.028-0.063 | 337.53-337.58 | 0.010-0.066 |337.54-337.63 | 0.015-0.080
26 341.06-341.13 | 0.026-0.063 | 341.54-341.60 | 0.005-0.059 |341.56-341.64 | 0.015-0.078
27 345.14-345.22 | 0.028-0.067 | 345.61-345.68 | 0.008-0.039 |345.61-345.69 | 0.006-0.079
28 349.38-349.46 | 0.021-0.062 | 349.77-349.81 | 0.006-0.055 |349.80-349.86 | 0.010-0.074
TPOX
5 364.37-364.50 | 0.073-0.107 | 365.42-365.42 | 0.013-0.013 | 365.34-365.44 | 0.043-0.119
6 368.42-368.52 | 0.061-0.110 | 369.45-369.45| 0.010-0.010 |369.37-369.50 | 0.040-0.112
7 372.46-372.59 | 0.054-0.102 | 373.51-373.51 | 0.008-0.008 |373.45-373.54 | 0.040-0.133
8 376.44-376.57 | 0.053-0.087 | 377.49-377.49| 0.010-0.010 |377.44-377.54 | 0.044-0.110
9 380.42-380.54 | 0.043-0.090 |381.52-381.52 | 0.014-0.014 |381.43-381.55| 0.050-0.113
10 384.44-384.56 | 0.037-0.093 | 385.53-385.53 | 0.005-0.005 |385.47-385.58 | 0.046-0.142
11 388.43-388.55 | 0.054-0.092 | 389.57-389.57 | 0.010-0.010 | 389.51-389.58 | 0.055-0.128
12 392.41-392.53 | 0.046-0.098 | 393.59-393.59 | 0.015-0.015 |393.50-393.60 | 0.065-0.121
13 396.42-396.53 | 0.042-0.095 |397.59-397.59 | 0.010-0.010 |397.52-397.63 | 0.066-0.124
14 400.41-400.53 | 0.050-0.102 |401.61-401.61| 0.013-0.013 |401.50-401.66 | 0.061-0.127
15 404.39-404.51 | 0.057-0.098 | 405.63-405.63 | 0.008-0.008 |405.51-405.64 | 0.047-0.141
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Extra peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram.
Causes for the appearance of extra peaks include stutter products, incomplete 3°
A nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples
(see DNA Advisory Board (DAB) Standard 8.1.2.2).

Extra peaks: Stutter

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller than the target STR allele product (minus stutter), or
less frequently, one repeat larger (plus stutter) (Butler, 2005; Mulero et al., 2006).
Sequence analysis of stutter products at tetranucleotide STR loci has revealed that
the minus stutter product is missing a single tetranucleotide core repeat unit relative
to the main allele (Walsh et al., 1996). Although plus-stutter is normally much less
significant than minus-stutter in STR loci with tetranucleotide repeats, the incidence
of plus-stutter may be more significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak.

Stutter observations

Peak heights were measured for amplified samples at the loci that are used in the
kit. All data were generated on the 3500xL Genetic Analyzer. Some conclusions from
these measurements and observations are:

* For each locus, the stutter percentage generally increases with allele length.

* Each allele within a locus displays a relatively consistent average stutter
percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified
in the software are not filtered.

* The measurement of stutter percentage for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.

* Stutter can be elevated when minus stutter and plus stutter overlap. This is
typically observed when a given allele flanks another allele that is 2 repeat units
away (as seen with the FGA locus in control 007 DNA).

¢ The magnitude and/or variability of stutter may increase with low DNA input
amounts.

Figure 17 through Figure 21 show the stutter observed in the population study that
are one repeat unit away from the alleles recorded. All data were generated on the
3500xL Genetic Analyzer.
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The stutter filter settings that are derived from this data are listed in “Stutter
percentage filter settings provided with GeneMapper™ ID-X Software” on page 88.

Plus-stutter was regularly observed and was more significant in trinucleotide repeat-
containing loci (see “Plus-stutter peaks at the D22S1045 locus” on page 87).
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Figure 17 Stutter percentages for the VeriFiler" Plus kit FAM™ dye (blue) channel loci:
D3S1358, vWA, D16S539, CSF1PO, and D6S1043.
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Figure 18 Stutter percentages for the VeriFiler" Plus kit VIC™ dye (green) channel loci:
D8S1179, D21S11, D18S51, and D5S818.
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Figure 20 Stutter percentages for the VeriFiler™ Plus kit TAZ™ dye (red) loci:

D22S1045, D1S1656, D13S317, D7S820, and Penta E.
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Stutter % vs. Marker & Allele
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Figure 21 Stutter percentages for the VeriFiler™ Plus kit SID™ dye (purple) loci:

Penta D, THO1, D12S391, D2S1338, and TPOX.

VeriFiler™ Plus PCR Amplification Kit User Guide

86



Chapter 6 Experiments and results 8¢
Extra peaks in the electropherogram ¢

Plus-stutter peaks at the D22S1045 locus

The D22S1045 STR locus in the VeriFiler™ Plus kit is a trinucleotide repeat locus, and
shows an elevated level of plus stutter (Figure 22). Other loci, such as FGA, may also
exhibit elevated plus stutter.

[pZZ510456 |
20 100 120

Main allele peak

Minus stutter
~ Plus stutter

Figure 22 VeriFiler" Plus kit electropherogram showing minus and plus stutter
associated with the D22S1045 STR locus. Data produced on a 3500xL Genetic
Analyzer.

STR loci such as D1S1656 (Figure 23) contain more complex nucleotide sequences
including regions of dinucleotide repeats which can yield additional stutter peaks. If
these stutter peaks exceed the peak amplitude threshold (typically 175 RFU), they
may be detected as additional alleles in the profile. The stutter file that is provided
with the GeneMapper™ ID-X Software for analysis of VeriFiler™ Plus kit data contains
a minus 2-nt stutter filter for D1S1656, as well as filters for commonly observed plus
stutter, to prevent these peaks from being called in normal profiles.

0151658
140 130 160 170 180

Main allele peak

-4 nt stutter

-2 nt stutter

Figure 23 Example of non-standard stutter peaks in the D1S1656 locus. In addition to
the main allele peaks and standard (-4 nt) stutter peaks, -2 nt minus stutter peaks and
+4 nt plus stutter peaks can also be observed. Data produced on a 3500xL Genetic
Analyzer.
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Stutter percentage filter settings provided with GeneMapper™ ID-X
Software

The settings in Table 8 were derived using the data that is shown earlier in this
section. The proportion of the stutter product relative to the main allele (stutter
percent) is measured by dividing the height of the stutter peak by the height of the
main allele peak.

Analysis showed that observed stutter data points were not normally distributed. As
such, at each locus a best-fit, non-parametric statistical model was applied to the
data and a threshold filter level that minimized the occurrence of non-filtered stutter
peaks while allowing maximum peak-detection sensitivity was determined.

IMPORTANT! The values that are shown in the table are the values that were
determined during developmental validation studies using specific data sets. To
determine the appropriate values to use for your applications, always perform internal
validation studies.

Table 8 Minus and plus stutter percentage filter settings provided with the
GeneMapper" ID-X Software

Note: Penta D and Penta E do not require plus stutter filters because their stutter levels are so low.

Locus [ Minus Stutter (%) Plus Stutter (%)
D3S1358 12.61 3.74
VWA 11.86 4.46
D16S539 11.19 4.05
CSF1PO 11.00 5.42
D6S1043 12.05 4.58
D8S1179 11.54 4.85
D21S11 13.83 5.04
D18S51 13.73 5.96
D5S818 10.90 4.64
D2S441 9.71 3.71
D19S433 11.00 5.91
FGA 14.01 7.96
D10S1248 12.48 3.13
D2251045 19.04 8.63
D1S1656 15.20 6.40
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Table 8 Minus and plus stutter percentage filter settings provided with the
GeneMapper ID-X Software (continued)

Locus [ Minus Stutter (%) Plus Stutter (%)
D13S317 11.00 6.25
D7S820 9.83 4.27
Penta E 7.99 —

Penta D 4.59 -

THO1 5.55 3.95
D12S391 15.61 6.10
D251338 16.69 8.00

TPOX 5.82 3.49

[ These percentages are used as stutter filters in VeriFiler_Plus_Stutter_v1.txt

Extra peaks: Addition of 3' A nucleotide

3’ A nucleotide addition definition

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3’ ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product
that is one nucleotide longer than the actual target sequence. The PCR product with
the extra nucleotide is referred to as the “+A” form.

3’ A nucleotide addition observations

The efficiency of +A addition is related to the particular sequence of the DNA at the 3°
end of the PCR product.

The VeriFiler™ Plus kit includes two main design features that promote maximum +A
addition:

* The primer sequences have been optimized to encourage +A addition.

* The PCR chemistry allows complete +A addition with a final incubation at 60°C
for 5 minutes.

This final extension step gives the DNA polymerase additional time to complete
+A addition to all double-stranded PCR products.Figure 24 shows examples of
incomplete and normal +A addition. Final extension incubation for longer than the
recommended time can result in double +A addition, in which two nontemplate
adenosine residues are added to the PCR product. Double +A addition can cause
"shoulders" on the right side of main allele peaks.
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Normal fully-adenylated VWA peaks
R

150

160 70 1%
'y j\ /\

VWA peaks with minus-A shoulders

150 160 70 1

Figure 24 The top panel shows normal VWA peaks that are fully adenylated, with no
visible shouldering and correct genotype calls. The bottom panel shows VWA peaks in
which adenylation was incomplete, resulting in minus-A shoulders that were called as

off-ladder (OL) peaks by the GeneMapper™ ID-X Software.

If the amount of input DNA is greater than recommended concentration,
"shouldering" of allele peaks can be observed. Amplification of excess input DNA
can also result in off-scale data and lowered IQCL peak heights. In this situation, the
IQCL may also exhibit some shouldering due to incomplete +A nucleotide addition.
Other adverse conditions may also result in incomplete adenylation, for example:
PCR inhibition, expired PCR reagents, or not completing the final hold step during
thermal cycling.

Extra peaks: Artifacts
Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible. Anomalies are non-reproducible, intermittent occurrences that
are not observed consistently in a system (for example, spikes and baseline noise).
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Dye artifact observation

Because of improvements in PCR primer manufacturing processes, the incidence
of artifacts has been greatly reduced in the VeriFiler" Plus kit. Internal population
studies show that kit electropherograms are free of reproducible dye artifacts in the
kit read region of 64-458 nt. Two exceptions are as follows:

* Alow-level 113-117 nt dye artifact in the VIC™ dye channel that has been
detected.

* A low-level ~66 nt dye artifact in the TED™ dye channel. This artifact was
approximately 40-80 RFU in our studies. The peak height observed may vary
depending on the sensitivity of individual CE instruments.

Figure 25 shows the low baseline-level fluorescence that is observed in a typical
negative control PCR. However, it is important to consider noise and other
amplification-related artifacts when interpreting data.
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Figure 25 Examples of fluorescence background in data produced on a 3500xL
Genetic Analyzer (Y-axis scale 0-200 RFU) (updated formulation)

Note the two FAM™ dye-labeled IQC peaks (IQCS and IQCL) that should normally be present in
negative samples.

Some small PCR artifacts were occasionally observed in negative control reactions
prepared with the VeriFiler™ Plus kit reagents that were subjected to long-term
storage at elevated temperature as part of stability testing. The most prominent and
consistent artifacts that were sometimes observed were:

* An artifact sizing at 120-130 bp in the FAM™ dye channel
* An artifact sizing at 110-120 bp in the VIC™ dye channel
For examples of these dye artifacts, see Figure 26. Such artifacts may form

spontaneously upon long-term storage of PCR reagents, but their formation can be
minimized by following the recommended storage conditions.
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Figure 26 Examples of FAM™ dye and VIC™ dye artifacts in negative (NTC) reactions
with VeriFiler" Plus kit reagents that were subjected to long-term storage at elevated
temperature

In this example, both artifact peaks are below 100 RFU.

Characterization of loci

SWGDAM guideline 3.1

Loci in this Kit

“The basic characteristics of a genetic marker should be determined and
documented.” (SWGDAM, December 2016)

This section describes basic characteristics of the 23 autosomal STR loci, Y indel
locus, and sex-determining marker (Amelogenin), that are amplified with the VeriFiler™
Plus kit. Most of these loci have been extensively characterized by other laboratories.

Nature of polymorphisms

92

The primers for the Amelogenin locus flank a 6-nucleotide deletion in intron 1 of

the X homolog. Amplification generates 102-nt and 108-nt products from the X

and Y chromosomes, respectively. The primers for the Y indel flank a region in

the g arm of the Y chromosome (Yq11.221). Depending on the haplotype of the
sample, the amplification generates either a 81-nt or a 87-nt product. (Sizes are

the actual nucleotide size according to sequencing results, including 3" A nucleotide
addition, and size may not correspond exactly to allele mobility observed on capillary
electrophoresis platforms.) Most of the STR loci present in the VeriFiler™ Plus kit
contain tetranucleotide repeat units. However, the kit also contains one locus with
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trinucleotide repeats (D22S1045) and two loci with pentanucleotide repeats (Penta D
and Penta E). The length differences among alleles of a particular locus are caused
by differences in the number of repeat units.

We have sequenced all the alleles in the VeriFiler" Plus Allelic Ladder, including
microvariants. In addition, other groups in the scientific community have sequenced
alleles at some of these loci (Nakahori et al., 1991; Puers et al., 1993; Mdller et al.,
1994; Barber et al., 1995; Mdller and Brinkmann, 1995; Barber et al., 1996; Barber
and Parkin, 1996; Brinkmann et al., 1998; Momhinweg et al., 1998; Watson et al.,
1998). Among the various sources of sequence data on the loci, there is consensus
on the repeat patterns and structure of the STRs.

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA

sets have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al., 1992).

The loci present in the VeriFiler" Plus kit have been mapped, and the chromosomal
locations have been published (Nakahori et al., 1991; Edwards et al., 1992; Kimpton
et al., 1992; Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al.,
1993; Barber and Parkin, 1996; and Lareu, et al., 1996).

As shown in Table 9, four sets of STR loci in the VeriFiler™ Plus kit are located on

the same chromosomes. Of these, the most closely spaced are VWA and D12S391,
which are located 6.3 million bp apart on the p arm of chromosome 12. Linkage
disequilibrium analysis was conducted on vVWA and D12S391 genotype results from
1,034 individuals of three ethnic groups (350 African American, 349 Caucasian, and
335 Hispanic) using the Linkage Disequilibrium module of GenePop software version
4.0.10 (Raymond and Rousset, 1995; Rousset, 2008).

The results of this analysis (not shown) indicated that there is no statistically
significant linkage disequilibrium found between vVWA and D12S391.
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However, an inheritance analysis of the CEPH pedigree families demonstrated a
degree of linkage between VWA and D12S391 that does not support the assumption
of independence for kinship analysis (Budowle, et al., 2010).

Table 9 Four sets of STR loci in the VeriFiler" Plus kit that are located on the
same chromosomes

Chromosome location
Locus Distance apart (Mb)
Map Mb units
D5S818 5923.2 123.139
26.297
CSF 5033.1 149.436
VWA 12p13.31 5.963
6.378
D12S391 12p13.2 12.341
D21S11 21g21.1 19.476
24.404
Penta D 21922.3 43.88
TPOX 2p25.3 1.472
66.741
D2S441 2p14 68.213
D2S441 2p14 68.213
150.492
D2S1338 2935 218.705

Species specificity
SWGDAM Guideline 3.2

“The ability to detect genetic information from non-targeted species (e.g., detection

of microbial DNA in a human assay) should be determined. The detection of genetic
information from non-targeted species does not necessarily invalidate the use of the
assay, but may help define the limits of the assay.” (SWGDAM, December 2016)
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Nonhuman studies

The VeriFiler™ Plus kit provides the required specificity for detecting human alleles.
Species specificity testing was performed to confirm that there is minimal cross-
reactivity with nonhuman DNA that may be present in forensic casework samples,
and to document the rarely observed examples of cross-species detection.

The following species were tested (in the specified amounts) using standard PCR and
capillary electrophoresis conditions for the VeriFiler™ Plus kit kit:

* Primates: chimpanzee, orangutan, and macaque (0.5 ng each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, rat, and cow (5.0 ng
each)

* Microorganisms: Streptococcus salivarius, Neisseria gonorrhea, Bacillus
subtilis, Candida albicans, Lactobacillus delbrueckii, Escherichia coli, and
Staphylococcus aureus (pooled genomic DNAs, with approximately 100,000
copies of DNA from each species, per reaction)

Results were evaluated for the presence of any amplified peaks that would indicate
cross reactivity of the VeriFiler™ Plus kit with any of these non-human species.

Figure 27 shows example electropherogram results from the species specificity tests.
Primate species (chimpanzee, macaque) produced more extensive cross-reactivity
than non-primate species, and for a closely related species like chimpanzee, many
peaks fell into allele bins. A few of the more distantly related mammals (bovine, dog,
horse) produced peaks over the 175 RFU threshold, all of which genotyped as "OL"
because they fell outside of allele bins. None of the remaining species that were
tested gave peaks over the detection threshold.
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Figure 27 Representative electropherograms for some species tested in a species
specificity study. Data produced on a 3500xL Genetic Analyzer (updated formulation)

Note: The individual panes are at different magnifications (zoom function) on the Y-axis.

Table 10 shows the most significant cross-reactive peaks that were observed among
non-human, non-primate, genomic DNAs (that is, peaks over a 175 RFU Peak
Amplitude Threshold on the 3500xL Genetic Analyzer), with the original and updated
formulations of the VeriFiler" Plus kit. Peaks were observed for dog, horse, hamster,
bovine, and sheep. No peaks fell into human STR locus bins, and would therefore not
be confused with human STR alleles. This data shows that the likelihood of obtaining
an allelic profile consistent with that from a human sample, from non-primates or
microorganisms, is extremely low.

Table 10 Observed cross-reactive peaks for non-human, non-primate animals for the original and updated
formulations of the VeriFiler” Plus kit

VeriFiler" Plus kit—Original VeriFiler" Plus kit—Updated
formulation formulation
Species Dye channel Size (bp)
Average peak Average peak
height (RFU) Genotype call height (RFU) Genotype call
Dog Blue 341 214 D6 OL - -
Red 307 692 PentaEOL |716 Penta E OL
Horse Green 98 630 Out of Marker | 828 OMR
Range (OMR)
Hamster Green 130 243 D8 OL - —

96
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Table 10 Observed cross-reactive peaks for non-human, non-primate animals for the original and updated
formulations of the VeriFiler Plus kit (continued)

VeriFiler” Plus kit—Original VeriFiler” Plus kit—Updated
formulation formulation

Species Dye channel Size (bp)

Average peak Average peak

height (RFU) Genotype call height (RFU) Genotype call
Bovine Red 221 399 D13 OL 489 D13 OL
Sheep Purple 211 345 THO1 OL 301 THO1 OL

Sensitivity

SWGDAM guideline 3.3

“The ability to obtain reliable results from a range of DNA quantities, to include the

upper and lower limits of the assay, should be evaluated.” (SWGDAM, December
2016)

Sensitivity observation

The recommended amount of input DNA for the VeriFiler™ Plus kit is 0.5 ng for

29 cycles of amplification based on real-time PCR quantification, such as with the
Quantifiler™ Trio DNA Quantification Kit or the Quantifiler” HP DNA Quantification Kit.
To determine the optimum input DNA, perform studies according to the quantification
kit that you use.

If the sample contains degraded DNA, amplification of a higher amount of DNA may
be beneficial. In Figure 28, DNA Control 007 was serially diluted from 1.0-0.016 ng.
Full profiles (46 human alleles) were consistently obtained at 0.125 ng, but occasional
partial profiles resulted at lower concentrations.
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Figure 28 Electropherograms for amplifications using 1,000, 500, 250, 125, 63, 31,
and 16 pg of DNA Control 007 (updated formulation)
Electrophoresis was performed on a 3500xL Genetic Analyzer. Note that because the DNA input is

serially diluted by 2-fold, the Y-axis scale is also magnified by 2-fold for the smaller input amounts of
DNA.

SWGDAM guideline 3.4

Degraded DNA

98

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults
should be evaluated. In most instances, assessment of the effects of these factors
on new forensic DNA procedures is not required. However, if substrates and/or
environmental and/or chemical insults could potentially affect the analytical process,
then the process should be evaluated to determine the effects of such factors.”
(SWGDAM, December 2016)

As the average size of degraded DNA approaches the size of the target sequence,
the amount of PCR product generated is reduced, because of the reduced number
of intact templates in the size range necessary for amplification. Degraded DNA was
prepared to examine the potential for differential amplification of loci. High-molecular-
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weight DNA was sonicated and incubated with increasing doses of DNase | (Bender
et al., 2004). The DNA was examined by agarose gel analysis to determine the
average size of the DNA fragments at each time point. Amplification of 0.5 ng of
degraded DNA using the VeriFiler" Plus kit was performed. As the DNA became
progressively degraded, the loci failed to amplify robustly in order of decreasing size.
Preferential amplification was not observed.
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Figure 29 Ampilification of a single donor DNA sample sonicated and incubated with
increasing doses of DNase | (updated formulation)

The panels show the control (undegraded), low-, medium-, and high-degraded samples. Note that
the Y-axis scale is magnified for more degraded samples, which generate lower peak heights.

Effect of inhibitors

Because of the substrates and environments from which they are collected, forensic
DNA samples may be contaminated with substances that inhibit PCR amplification.
The PCR chemistry for the VeriFiler" Plus kit was optimized to be as robust

as possible in the presence of such inhibitors. Model inhibitors tested during
developmental validation were: hematin, a representative compound often extracted
from blood stains (DeFranchis et al., 1988; Alkane et al., 1994); humic acid, a
simulant for soil-based inhibition; and tannic acid, a compound often co-extracted
from leather sample substrates. 0.5 ng of DNA Control 007 was amplified in the
presence of increasing concentrations of each model inhibitor. All samples were then
amplified using the standard 29-cycle "touchdown" thermal cycling program.

Figure 30 and Figure 31 show representative electropherograms from the PCR
inhibitor studies with humic acid, hematin, and tannic acid. Table 11 shows inhibitor
final concentrations in 25-uL PCR reactions and average allele counts obtained in
replicate reactions with the VeriFiler" Plus kit.
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Figure 30 Electropherograms show the results of testing the VeriFiler” Plus kit with
the humic acid PCR inhibitor (updated formulation)
The top panel is the experimental control with 0.5 ng (total) of DNA Control 007 without humic acid.
The remaining panels show 0.5 ng of DNA Control 007 with increasing levels of humic acid (150,
250, and 350 ng/pL). Note the behavior of the IQCS and IQCL peaks in response to increasing levels
of inhibition, with the IQCL peak decreasing in peak height and eventually disappearing as the humic

acid concentration increases.

Note: The individual panes are at different magnifications (zoom function) on the Y-axis.
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Figure 31 Example electropherograms show the results of testing hematin and tannic
acid PCR inhibitors (updated formulation)

Each sample contained 0.5 ng (total) of human male DNA Control 007 with varying levels of hematin
or tannic acid. Note that the IQCL peak was significantly reduced or absent while the IQCS peak still
remained in the inhibitor-containing samples.

Note: The individual panes are at different magnifications (zoom function) on the Y-axis.

Table 11 VeriFiler" Plus kit performance with PCR inhibitors (N = 4) (updated

formulation)
Sample Inhibitor concentration Mean allele count

Control (no inhibitor) 0 46
Hematin low 400 uM 46
Hematin medium 500 uM 46
Hematin high 600 uM 8.75
Humic acid low 150 ng/pL 46
Humic acid medium 250 ng/pL 46
Humic acid high 350 ng/uL 42.5
Tannic acid low 250 ng/pL 46
Tannic acid medium 350 ng/uL 46
Tannic acid high 450 ng/pL 46
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Mixture studies

SWGDAM guideline 3.8

“The ability to obtain reliable results from mixed source samples should be
determined.” (SWGDAM, December 2016)

Mixture study overview

102

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. Perform
studies to determine a minimum peak height threshold to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an important category of forensic casework.

It is essential to ensure that the DNA typing system is able to detect DNA mixtures.
Typically, mixed samples can be distinguished from single-source samples by:
* The presence of more than two alleles at one or more loci

* The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

* Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by
the height of the higher peak (in RFU), expressed as a percentage.

If an unusually low peak height ratio is observed for one locus, and there are no
other indications that the sample is a mixture, reamplify and reanalyze the sample to
determine if the imbalance is reproducible. Possible causes of imbalance at a locus
are:

* Degraded DNA

* Presence of inhibitors

¢ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele
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Mixture study observation

Median, minimum, and maximum peak height ratios observed for alleles in the
VeriFiler™ Plus kit loci in single-source human population database samples are
shown in Figure 32. The population samples that are used are listed in “Population
samples used in these studies” on page 108.
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Figure 32 Heterozygote ratios for ~0.5 ng of input DNA. Intra-locus peak height ratio
is calculated per individual profile by dividing the lower peak by the higher peak in
each heterozygote allele pair, per marker. Box plot boxes and data points are colored
according to the dye channel. Boxes show the middle 50% or interquartile range (IQR).
Box halves below and above median show the second and third quartile, respectively.
"Whiskers" indicate 1.5 IQR from the upper and lower margins of the IQR. Black dots
are outlier data points more than 1.5 IQR from the median.

Resolution of genotypes in mixed samples

A sample containing DNA from two sources can comprise (at a single locus) any of
the seven genotype combinations (see below).

* Heterozygote + heterozygote, no overlapping alleles (four peaks)
* Heterozygote + heterozygote, one overlapping allele (three peaks)
* Heterozygote + heterozygote, two overlapping alleles (two peaks)
* Heterozygote + homozygote, no overlapping alleles (three peaks)
* Heterozygote + homozygote, overlapping allele (two peaks)
* Homozygote + homozygote, no overlapping alleles (two peaks)
* Homozygote + homozygote, overlapping allele (one peak)
Specific genotype combinations and input DNA ratios of the samples contained in a

mixture determine whether or not it is possible to resolve the genotypes of the major
and minor components at a single locus.
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Mixture studies

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems™ instruments provides additional valuable data to aid
in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference samples.

Note: Peak detection is a complex process that involves the STR chemistry,
capillary electrophoresis conditions, and the data analysis software. Contact HID
Support for a Technical Note with additional information on detecting peaks in
electropherograms.

Limit of detection of the minor component

104

Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 1:3, 1:7,
1:15, 1:30, 30:1, 15:1, 7:1, 3:1 and 1:0). The total amount of genomic input DNA
mixed at each ratio was 0.5 ng. The samples were amplified in a ProFlex " 96-well
PCR System, then electrophoresed and detected using an 3500xL Genetic Analyzer.

The results of the mixed DNA samples are shown in Figure 33. The two human
genomic DNAs, male 007 and female 9947a, were mixed according to the ratios
indicated. The minor component allele calls at non-overlapping loci are highlighted.
Detection of full profiles for the minor contributor was possible at ratios of 7:1
(0.438 ng of 007 and 0.063 ng of 9947a) and 1:7 (0.063 ng of 007 and 0.438 ng

of 9947a), with 3/3 replicates of both samples giving full profiles of the respective
minor contributor. 15:1, 30:1, 1:30, and 1:15 ratios resulted in partial profiles for the
minor component (Table 13). The genotypes of each contributor DNA are shown in
Table 12.

Table 13 shows mixture sample compositions and mean STR allele counts from
VeriFiler™ Plus kit assays.
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Figure 33 Amplification of DNA mixtures at various ratios (updated formulation)

Panels show electropherograms for 1:0 (male 007 DNA only), 1:7 mixture, 1:1 mixture, 7:1 mixture,
and 0:1 (female 9957a DNA only).
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Table 12 Genotypes of mixture sample contributors (updated formulation)

Asterisks denote alleles that are unique for each individual, and also apart from plus- or minus-
stutter positions of other alleles present in the individuals.

Male 007 genotype Female 9947a genotype
Marker
Allele 1 Allele 2 Allele 1 Allele 2
D3S1358 15 16* 14 15
VWA 14* 16 17* 18*
D16S539 9* 10 11* 12*
CSF1PO 11 12 10 12
TPOX 8 - 8 -
Yindel 2* - — -
AMEL X Y* X -
D8S1179 12 13 13 -
D21S11 28* 31" 30 -
D18S51 12* 15 15 19*
D2S441 14 15* 10* 14
D19S433 14 15 14 15
THO1 7 9.3 8" 9.3
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Mixture studies

Table 12 Genotypes of mixture sample contributors (updated
formulation) (continued)

Male 007 genotype Female 9947a genotype
Marker
Allele 1 Allele 2 Allele 1 Allele 2
FGA 24 26" 23 24
D22S1045 11 16* 11 14*
D5S818 11 - 11 -
D13S317 11 - 11 -
D7S820 7 12* 10* 11
D10S1248 12 15 13* 15
D1S1656 13* 16* 18.3* -
D12S391 18 19 18 20"
D2S1338 20* 23 19 23
D6S1043 12 14* 12 18*
Penta E 7* 12 12 13*
Penta D 11 12 12 —

Table 13 Mixture sample compositions and mean STR allele counts from
VeriFiler” Plus kit assays (updated formulation)

_ DNA amounts (ng/reaction) Mean allele countl']
I:;::::: Ratio (A:B) | Male 007 Female Male 007 Female
("A") 9947a ("B") ("A") 9947a ("B")

A 1:0 0.500 0.000 18.00 0.00
B 1:1 0.250 0.250 18.00 14.00
C 1:3 0.125 0.375 18.00 14.00
D 1:7 0.063 0.438 18.00 14.00
E 1:15 0.031 0.469 15.33 14.00
F 1:30 0.016 0.484 12.67 14.00

G 30:1 0.484 0.016 18.00 7.33
H 15:1 0.469 0.031 18.00 10.67
| 71 0.438 0.063 18.00 14.00
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Table 13 Mixture sample compositions and mean STR allele counts from VeriFiler
Plus kit assays (updated formulation) (continued)

DNA amounts (ng/reaction) Mean allele countl']
Mixture Ratio (A:B
sample atio (A:B) Male 007 Female Male 007 Female
(IIAII) 9947a (IIBII) (IIAII) 9947a (IIBII)
J 3:1 0.375 0.125 18.00 13.67
K 0:1 0.000 0.500 0.00 14.00

1 Mixture sample compositions and STR allele counts from VeriFiler™ Plus kit assays. The average number of
unique, distinct alleles (that is, alleles neither present in the other contributor genotype nor located in a stutter
position) obtained in 3 replicate reactions per mixture sample. The full profiles of unique alleles in 007 and
9947a DNAs were 18 and 14, respectively.

Population data

SWGDAM guideline 3.7

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, December 2016)

Population data overview

Loci in the kit

To interpret the significance of a match between genetically typed samples, you must
know the population distribution of alleles at each locus in question. If the genotype
of the relevant evidence sample is:

¢ Different from the genotype of the reference sample for a suspect, then the
suspect is excluded as the donor of the biological evidence that was tested.
An exclusion is independent of the frequency of the two genotypes in the
population.

* The same as the genotype of the reference sample for a suspect, then the
suspect is included as a possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence
sample is estimated by the frequency of that genotype in the relevant populations.

The VeriFiler™ Plus PCR Amplification Kit was designed and optimized primarily for
the analysis of forensic casework samples. It was designed as a companion kit to
the VeriFiler™ Express PCR Amplification Kit (Cat. No. A32014) and the Huaxia™
Platinum™ PCR Amplification Kit (Cat. No. A31323), and contains the same set of 25
loci.
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Population samples used in these studies

108

The VeriFiler™ Plus kit has high genotypic concordance (>99.5%) to its databasing
counterparts, the VeriFiler" Express kit and Huaxia" Platinum™ kit (all three kits
contain the same 25 loci). An initial population study of individuals of different
ethnic populations within the United States and China was conducted with

2,475 individuals. This initial study was the basis for the allele frequency tables and
associated random match probability tables at the end of this section.

After the minor redesign of certain primers in the VeriFiler" Plus kit multiplex to
reduce the incidence of artifact peaks in samples with high levels of bacterial DNA, a
new population study was performed to check:

* Concordance between the original and redesigned VeriFiler" Plus kits
e Concordance with the GlobalFiler™ kit reference genotypes
As with the original population study, the study with the updated formulation included

in-house testing of domestic United States individuals as well as population samples
collected and tested by laboratories in China. See Table 14.

Table 14 Population samples (updated formulation)

Sample source Total No. of samples by ethnic
. sample Sample type .
(population) s origin

In-house testing 1,308 * Extracted DNAs from ® African-American—285
of domestic 1,108 blood samples e Asian—316

United States * 200 samples from o
individuals blood cards that
were tested in direct
amplification mode

Caucasian—322
* Hispanic—385

Chinese 987 |Blood cards that were Individuals of Chinese origin
laboratories tested in direct amplification | —987
mode
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Concordance studies

Concordance between the original VeriFiler" Plus kit and the redesigned kit was
100% for 2,288 samples tested in-house and externally. When genotype results were
compared between the VeriFiler™ Plus kit and the GlobalFiler™ kit, the following level
of concordance was observed:

Sample source

(el e Sample type Level of discordance
In-house testing of | Extracted DNAs from 1,099/1,108 (discordances
domestic United 1,108 blood samples observed in D10S1248 and
States individuals D3S1358)

200 samples from blood cards | 200/200 (0 discordances
that were tested in direct observed)
amplification mode

Chinese laboratories | Blood cards that were tested in | 986/987 (1 discordance
direct amplification mode observed in D5S818)

Among the in-house extracted samples, several instances of discordance were
observed that were caused by a 1-bp insertion in the flanking region of D10S1248.
Affected individuals genotyped as off-ladder (OL). The same individuals tested with
the GlobalFiler™ kitdid not give the OL genotypes. All individuals that contained

the 1-bp insertion were of African descent, and subsequent database searches
confirmed that this indel is found almost exclusively in individuals of African ancestry.

D10S2148 in the VeriFiler™ Plus kit

The VeriFiler" Express kit and Huaxia™ Platinum™ kit were designed for database
workflows that involve pristine single-source samples. The VeriFiler" Plus kit was
designed for casework workflows that involve challenging samples. Although the
three kits are complementary, the VeriFiler" Plus kit was modified to optimize
casework performance and discrimination power with degraded samples. In the
VeriFiler™ Plus kit, more discriminating markers (such as the Penta D marker)

were given priority for amplification and located in the smaller molecular weight
regions, while the D10S1248 marker, because of its lower discrimination power, was
positioned in the larger molecular weight region.

To move the D10S1248 marker from a smaller base pair size in the SID™ dye channel
to the larger base pair size in the TED™ dye channel, the flanking region that borders
the primer binding and STR sites was extended. By sequencing additional base
pairs in the flanking region of the D10S1248 marker, the opportunity to observe rare,
sample-specific mutations increases.

In the case of six African-American (out of 330) and one Hispanic (out of 393)
population samples, an insertion in the flanking region for the D10S1248 marker
caused a 1-bp difference when comparing results from the VeriFiler™ Plus kit to
the VeriFiler™ Express kit, Huaxia™ Platinum™ kit, and GlobalFiler™ kit (Figure 34).
This was seen with alleles 13, 14, and 15 reported as 13.1, 14.1, and 15.1. The
discrepancy has not been observed in any other population samples tested (1,335
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total combined Caucasian and Asian samples). Subsequent sequencing of the
sample showed that it is consistent with African lineage. This D10S1248 insertion
is observed in the original and updated formulations of the VeriFiler" Plus kit.

a7 280 290 400 410 a0

E000
12000
g0o0
d0on
o

Figure 34 D10S1248 marker from an African American population sample amplified
with the VeriFiler” Plus kit

The off-ladder (OL) peak sizes at the 14.1 base pair position because of a single base pair insertion
in the flanking region between the primer and STR region. When amplified with the VeriFiler™
Express kit, Huaxia™ Platinum™ kit, and GlobalFiler™ kit, the genotype at this marker would be 14,
15.

Supporting data

Additional studies were performed at the National Institute of Standards and
Technology (NIST, C.R. Steffan). Those studies confirmed the above conclusions,
showing the 1-bp difference in nine out of 355 African-American samples.

For expanded frequency analysis of this insertion, we examined the sequencing data
for the specific insertion at the D10S1248 marker from the following organizations:

* Broad Institute (https://gnomad.broadinstitute.org/variant/10-131092326-T-
TA?dataset=gnomad_r2_1)

* 1,000 Genomes Project (https://www.internationalgenome.org/about)
* NCBI (https://www.ncbi.nlm.nih.gov/snp/rs567190580#frequency_tab)

Out of 5,044 total African-related samples, there were 80 observations. Out of
771 total Hispanic-related samples, the insertion was not observed.

VeriFiler™ Plus PCR Amplification Kit User Guide
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Next steps and considerations

The potential to observe discrepant genotypes among STR PCR kits that use
different primer sequences is a known phenomenon in the forensic community.
Depending on workflow, interpretation protocols, and database search parameters,
each laboratory may take a different approach to handling discrepancies across STR
PCR kits.

If your laboratory has an established protocol for handling these discrepancies, we
recommend that you follow that protocol for this occurrence. If your laboratory does
not have an established protocol, we recommend that you consider different analysis
and database search approaches, some of which include:

e Evaluate previously generated VeriFiler™ Plus kit files that contain
0.1 microvariant calls at the D10S1248 marker.

* Confirm the genotype through amplification with a secondary STR PCR kit, such
as the GlobalFiler™ kit.

* Exclude the D10S1248 marker from upload to a database if the 0.1 microvariant
is observed.

* Perform database searches that include one mismatch when a database is
composed of profiles from different STR PCR Kkits.

Probability of Identity definition

The P, value is the probability that two individuals selected at random will have an
identical genotype (Sensabaugh, 1982).
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Probability of identity

Figure 35 through Figure 39 show the autosomal STR allele frequencies at VeriFiler" Plus kit loci by population
group.

Note: These tables show observed allele frequencies among different population groups. To ensure a
conservative approach when performing statistical calculations such as profile frequency estimates, minimum
allele frequencies should be used for very rare alleles that may be insufficiently sampled in a population. For
autosomal markers, minimum allele frequencies are typically calculated as 5/2N, where N is the number of
individuals sampled in a given population (Butler, 2010).

Table 15 shows the Random Match Probability (RMP) values of the VeriFiler"™ Plus kit loci individually and
combined.
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Figure 35 Combined China populations (minimum allele frequency = 0.0010)
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Combined China populations (continued)
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Combined China populations (continued)
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Figure 36 United States— African-American population

(minimum allele frequency = 0.0082)
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United States— African-American population (continued)
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Figure 37 United States—Asian-American population (minimum allele frequency = 0.0066)
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302 0.0160

303 0.0066

31 D.1144

312 00793

LV 0.0279

322 01157

33 0.0027

United States— Asian-American population (continued)
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5 0.0632 0.0015

G 0.0015 0.0030 0.2255 0.0015

7 00015 00119 00074 | 01528 | 0.4780

8 0.0030 0.10%8 0.0148 0.0074 0.1538 0.0193 0.0039 0.0119 0.1098 0.5059

a 0.0267 0.0742 01291 0.0059 0.0534 0.1662 0.0134 0.1855 0.0148 0.1706 01276

03 0.3056

10 0.2549 0.0682 0.0415 0.0119 0.0015 0.0030 0.0030 0.1938 0.0534 0.0074 0.2745 0.1083 0.1350 0.1068 0.0089 0.0450

11 0.3056 0.0058 02834 03190 0.0038 0.0623 01380 0.3412 0.0030 0.3442 0.3085 0.2166 0.0653 0.1602 0.1248 02739
113 0.0504

12 0313 0.0341 0.3071 0.3056 0.1528 0.0653 0.1602 0.0045 0.0401 0.3724 0.25587 0.1454 0.1558 0.2131 0.1730 0.0371
121 0.0015
122 0.0015
123 0.0015

13 0.0638 0.2932 01113 01706 0.11387 0.2760 0.0697 0.0074 0.0015 0.0329 0.0015 0.1434 0.0742 0.0237 0.3249 0.2062 0.0831 0.0015
132 0.0163

14 | oooso | 02997 00445 | 00178 | 0.1751 | 03501 | 0.0823 00371 | 00015 | 02849 | 01528 | 0.0173 | 0.0490 | 0.0015 | 0.1914 00579 | 0.0519 0.0861
141 0.0015
142 0.0223
143 0.0030

15 0.1914 0.0445 0.0015 0.1528 0.1662 0.1528 0.3650 0.0015 0.0430 02774 0.0030 0.0134 0.0015 0.0905 0.0134 0.0475 0.1245
152 0.0356
153 0.0890

16 0.1320 0.0341 0.1088 0.0549 0.0879 0.3620 0.0430 0.0015 0.2329 0.0045 0.0232 0.0015 0.0030 0.0519 0.2166
16.2 0.0030
16.3 0.0430

17 0.0356 0.0854 0.1038 0.0030 0.0445 00712 0.1859 01938 0.0653 0.0030 0.0015 0.0415 0.2760
171 0.0030

Figure 38 United States—Caucasian population (minimum allele frequency = 0.0074)
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172 0.0015
173 0.0208 0.1246
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183 0.0223 0.0579
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202 0.0045
203 0.0015
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222 0.0089
23 0.0816 0.0020 0.0979 0.1469
232 0.0045
233 0.0015
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26 0.0030 0.0030 0.0178 0.0178
27 0.0015 0.0282 0.0030 0.0059
28 0.1632 0.0015
29 0.2339
2092 0.0015
293 0.0015
20 0.2389
302 0.0267
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3.2 0.0830
32 0.0237

United States—Caucasian population (continued)
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37 0.0026
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T 0.0032 0.0026 0.0537 0.0118 0.0052 0.1021 0.3207 0.0013
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10 02605 0.0013 0.0942 01558 0.0065 0.0039 0.0026 0.0052 D.3088 00471 0.0105 02579 00832 01832 00684 00144 00563
103 0.0013
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112 0.0026
113 0.0432 0.0013

12 0.3691 0.0445 0.2866 0.2435 0.1036 0.0812 0.0916 0.0105 0.0419 00013 0.2958 0.1715 0.1963 0.1257 0.1819 0.1638 0.0013 0.1036 0.0026
12.2 0.0144
123 0.0038

13 0.0419 0.2592 0.0013 0.0929 01401 0.1178 0.1872 0.0631 0.0032 0.0170 0.0039 0.1492 0.1047 0.0419 0.3220 0.0013 0.1638 0.1008 0.0013 0.0013
132 0.0707

14 0.0052 0.3547 0.0013 0.0432 00131 0.1558 0.3010 0.1089 0.0223 0.2264 0.0877 0.0105 0.1427 0.0052 0.2356 0.0539 0.0707 0.0013 0.0654
142 00013 | 0.0445
143 0.0026

15 0.0026 0.2291 0.0366 0.0013 0.0026 0.1257 0.1309 0.1636 0.4254 0.0327 0.3442 0.0445 01178 0.0133 0.0812 0.0969
152 00013 | 0.0733
153 0.0275

16 0.0812 0.0437 0.1257 0.0406 01571 0.3539 0.0366 0.0028 02723 0.0065 0.0340 0.0013 0.0802 0.3076
16.1 0.0026
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Figure 39 United States—Hispanic population (minimum allele frequency = 0.0065)
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163 0.0537

17 0.0236 | 0.0733 | D.0026 0.1636 | 0.0085 | 0.0707 0.0798 | 0.1780 0.1780 0.0537 0.0065 0.0576 0.2709
171 0.0026

172 0.0039

173 0.0118 0.1558

18 0.2003 0.0851 0.0065 0.0118 | 0.0881 0.1021 0.0995 0.0065 0.0340 0.1819
183 0.0209 0.0432

19 01885 00330 01846 00092 0.0720 00694 | 00026 | 00183 00854
193 0.0105 0.0065 0.0039

20 0.1688 0.0183 0.0013 | 0.1361 0.0432 0.0803 0.0301 0.0065
202 0.0026
203 0.0118

21 0.0916 0.0236 0.0366 0.0105 0.1401 0.0209
213 0.0432

22 0.0668 0.0065 0.0628 0.1387 0.0105
222 0.0065
273 0.0131

23 0.0366 0.0052 0.1401 0.1243 0.0052 0.0039
232 0.0039
233 0.0039

24 00013 | 00183 0.0026 00838 01649
242 0.0026

25 0.0118 0.0013 0.0550 0.1401

26 0.0026 0.0039 0.0157 0.0631

27 0.0026 0.0144 0.0013 0.0301

28 0.1139 0.0013 0.0079
282 0.0013

29 02107 0.0039

30 02723 0.0013

30.2 0.0144

United States —Hispanic population (continued)
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31 0.0497
31.2 0.1139
32 0.0157
322 0.1257
33 0.0013
33.2 0.0550
35 0.0026
36 0.0013
38 0.0013
United States—Hispanic population (continued)
Table 15 Random Match Probability (RMP) values for VeriFiler” Plus kit markers
Allele Combined China African-American Caucasian Asian-American Hispanic
CSF1PO 0.1168 0.0792 0.1289 0.1221 0.1289
D10S1248 0.0938 0.0672 0.0931 0.1007 0.0931
D12S391 0.0427 0.0362 0.0198 0.0408 0.0198
D13S317 0.0643 0.1363 0.0735 0.0675 0.0735
D16S539 0.0799 0.0727 0.0981 0.0836 0.0981
D18S51 0.0343 0.0300 0.0289 0.0366 0.0289
D19S433 0.0526 0.0361 0.0895 0.0549 0.0895
D1S1656 0.0440 0.0315 0.0195 0.0490 0.0195
D21S11 0.0509 0.0419 0.0466 0.0508 0.0466
D2251045 0.0883 0.0504 0.1367 0.0844 0.1367
D251338 0.0318 0.0198 0.0279 0.0321 0.0279
D2S441 0.0858 0.0996 0.0976 0.0897 0.0976
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Table 15 Random Match Probability (RMP) values for VeriFiler Plus kit markers (continued)

Allele Combined China African-American Caucasian Asian-American Hispanic
D3S1358 0.1262 0.1033 0.0757 0.1222 0.0757
D5S818 0.0870 0.0952 0.1290 0.0907 0.1290
D6S1043 0.0287 0.0248 0.0584 0.0313 0.0584
D7S820 0.0799 0.0747 0.0678 0.0905 0.0678
D8S1179 0.0449 0.0700 0.0604 0.0462 0.0604
FGA 0.0345 0.0301 0.0370 0.0393 0.0370
Penta D 0.0594 0.0237 0.0530 0.0577 0.0530
Penta E 0.0115 0.0188 0.0199 0.0121 0.0199
THO1 0.1490 0.0885 0.0811 0.1641 0.0811
TPOX 0.2129 0.0860 0.1785 0.2141 0.1785
VWA 0.0674 0.0602 0.0624 0.0641 0.0624

Cumulative 1.34x 1028 2.13x10°%0 1.24 x 1028 3.09x10°28 1.24 x 1028
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Population data

Probability of paternity exclusion observation

If your laboratory requires the probability of paternity exclusion calculation, contact
your Thermo Fisher Scientific HID representative.
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from both the
DNA Control 007 and the DNA

test samples at all loci, including
the IQC markers

The incorrect volume of Master
Mix or Primer Set was used.

Use the correct volume of Master Mix or Primer
Set.

The DNA Polymerase was not
activated.

Repeat the amplification with an initial hold at
95°C for 1 minute.

The Master Mix was not
vortexed thoroughly before
aliquoting.

Vortex the Master Mix thoroughly.

The Primer Set was exposed to
too much light.

Replace the Primer Set and store it protected
from light.

Evaporation.

Ensure that the plate is properly sealed with

film and that a compression pad was used

with the GeneAmp™ PCR System 9700. (Do not
use a compression pad with the other validated
thermal cyclers.)

The thermal cycler
malfunctioned.

See the thermal cycler user manual and check
the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

A MicroAmp™ base was used
with a tray/retainer set and tubes
in GeneAmp™ PCR System
9700.

Remove the MicroAmp™ base.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the block after
first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with Caps or
the MicroAmp™ Optical 96-well Reaction Plate
for the GeneAmp "™ PCR System 9700 or Veriti™
Thermal Cycler.

Insufficient PCR product was
electrokinetically injected.

Use correct genetic analyzer settings.

Degraded formamide was used.

Check the storage of formamide. Do not
thaw and refreeze multiple times. Try Hi-Di™
Formamide.

130
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Appendix A Troubleshooting
Population data

Observation

Possible cause

Recommended action

Positive signal from DNA Control
007 but partial or no signal from
DNA test samples when IQC

peaks are present and balanced

The quantity of test DNA sample
is below the assay sensitivity.

Quantify DNA and (when possible) add 500 pg
of DNA. For low concentration samples, add up
to 17.5 pL of the DNA sample to the reaction
mix.

The test sample DNA is severely
degraded.

Use the Quantifiler™ HP DNA Quantification Kit
or the Quantifiler™ Trio DNA Quantification Kit to
evaluate sample quality during the quantification
step. If DNA is degraded, reamplify with an
increased amount of DNA or consider using the
Precision ID GlobalFiler™ NGS STR Panel.

The test sample was diluted in
the wrong buffer (for example, a
TE buffer with an incorrect EDTA
concentration).

Redilute DNA using nuclease-free water or low-
TE buffer (with 0.1 mM EDTA).

Positive signal from DNA Control
007 but partial or no signal

from DNA test samples when
IQC peaks are present and
unbalanced

The test sample contains a high
concentration of PCR inhibitor
(for example, heme compounds,
certain dyes).

Quantify the DNA, then use the minimum
necessary volume of test sample DNA.

Wash the sample in a Centricon™-100
centrifugal filter unit.

The test sample was diluted in
the wrong buffer (for example, a
TE buffer with an incorrect EDTA
concentration).

Redilute DNA using nuclease-free water or low-
TE buffer (with 0.1 mM EDTA).

Positive signal from DNA
Control 007 and elevated signal
from DNA test samples when
IQC peaks are present and
unbalanced

The quantity of the test

sample DNA is in excess of
recommended input amount,
which can cause loss of balance
in 1QC peaks.

Quantify DNA, then use 500 pg.

More than two alleles present at
alocus

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Stutter product (-1 repeat unit
position) was amplified.

Ensure that you apply the provided locus-
specific stutter filters.

Stutter filters apply to sample
input amounts equal or greater
than 250 pg. Samples well
below the recommended input
amount may exhibit stutters
values exceeding the filters due
to the stochastic effects of the
PCR.

Increase the sample input above 250 pg, if
possible. (Note, the optimum sample input is
500 pg.)

The test sample contained
mixed DNA.

If a mixed profile is not expected, check that
laboratory protocols relating to cleanliness are
followed.
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Appendix A Troubleshooting

Population data

Observation

Possible cause

Recommended action

More than two alleles present at
a locus
(continued)

Incomplete 3" A base addition
(n—1 nt position) occured.

Include the final extension step of 60°C for
5 minutes in the PCR.

Remove amplified plate from storage (thaw if
necessary) and place on thermal cycler at 60°C
for 15 minutes.

Check the quantity of the original sample
DNA to ensure input is less than 750 pg per
reaction. Adjust input as necessary during re-
amplification.

If the total amount of DNA in the reaction
exceeds 1 ng, adjust the final extension time to
15 minutes to minimize incomplete 3’ A base
addition.

The signal exceeds the dynamic
range of the instrument and

is causing signal "pull-up" into
adjacent channels.

Check that you are using the recommended
number of PCR cycles. Repeat PCR
amplification using reduced input DNA amount,
or interpret the off-scale data according to your
laboratory procedure.

Check that you are using the recommended
injection conditions on the instrument.

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6-T modules are
installed and used for analysis.

Too much DNA was present in
the reaction.

Use the recommended amount of template
DNA: 500 pg for 29 PCR cycles.

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di"™
Formamide and heat the sample plate at 95°C
for 3 minutes.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

Some but not all loci visible on
electropherogram of DNA Test
Samples

The DNA guantity was too low,
leading to stochastic effects.

Load more DNA sample or concentrate the
DNA.

STR profiles contain many off-
scale alleles

DNA quantification was not
performed or not accurate.

Ensure that DNA quantification is accurate.

132

VeriFiler™ Plus PCR Amplification Kit User Guide




Materials required but not supplied

Sample preparation required materials .. ...
Thermal cycler required materials ..........
Genetic analyzer required materials ........
Analysis software required materials . ......

Miscellaneous required materials ..........

Unless otherwise indicated, all materials are available through thermofisher.com.
"MLS" indicates that the material is available from fisherscientific.com or another

major laboratory supplier.

Sample preparation required materials

Item Source
GeneScan" 600 LIZ"™ Size Standard v2.0, 2 x 200 pL 4408399
IMPORTANT! Do not use GeneScan™ 350 ROX™, GeneScan" 500 ROX",
or GeneScan" 500 LIZ" Size Standards with this kit.
Hi-Di"™ Formamide, 25-mL 4311320
Invitrogen™ Nuclease-Free Water (not DEPC-Treated) AM9937
(Optional) Invitrogen™ TE Buffer (low-TE buffer; 10 mM Tris-HCI pH 8.0 and 12090015

0.1 mM EDTA)

or see “(Optional) Prepare low-TE
buffer” on page 22.

Thermal cycler required materials

ProFlex™ PCR System

Item Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073

VeriFiler™ Plus PCR Amplification Kit User Guide

133


http://www.thermofisher.com
http://fisherscientific.com

Appendix B Materials required but not supplied
Genetic analyzer required materials

Veriti" Thermal Cycler

Item Source
Veriti" 96-Well Thermal Cycler 4479071
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
GeneAmp™ PCR System 9700
Iltem Source
GeneAmp" PCR System 9700, 96-Well Silver N8050001
GeneAmp™ PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
Genetic analyzer required materials
3500 Series Genetic Analyzer
Item Source
3500 Series Data Collection Software 4, v4.0.1 software patch A40059 or A40376!"]
3500 Series Data Collection Software 3.1 Upgrade (RUO) A26287!1]
3500 Series Data Collection Software 3.1 (RUO) 4475183
HID Updater 3500 Data Collection Software v2 4480670
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-37 Matrix Standard Kit (Dye Set J6-T) A31234
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231

134 VeriFiler™ Plus PCR Amplification Kit User Guide



Appendix B Materials required but not supplied
Analysis software required materials

(continued)
Item Source
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
[l Contact your Thermo Fisher Scientific HID representative.
3130 Series Genetic Analyzer required materials
Iltem Source
3130 Data Collection Software v4 4475105
3130x/ Data Collection Software-v4 4475126
3130/3730 Data Collection Software-v4 6-Dye Module v1 4478404
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130/3130x/ Genetic Analyzer 16-Capillary Array, 36 cm 4315931
POP-4" Polymer for the 3130/3130x/ Genetic Analyzer 4352755
Running Buffer, 10X 402824
DS-37 Matrix Standard Kit (Dye Set J6-T) A31234
MicroAmp"™ Optical 96-Well Reaction Plate N8010560
Analysis software required materials
GeneMapper™ ID-X Software
Item Source
GeneMapper" ID-X Software v1.6 Full Installation A39975
GeneMapper" ID-X Software v1.6 Client Installation A39976
GeneMapper" ID-X Software v1.5 Full Installation A27884
GeneMapper" ID-X Software v1.5 Client Installation A27886
GeneMapper" ID-X Software v1.4 Full Installation 4479707
GeneMapper" ID-X Software v1.4 Client Installation 4479711
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Appendix B Materials required but not supplied
Miscellaneous required materials

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp"™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp"™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp"™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLS!]
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

' Major laboratory supplier
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PCR work areas

Work areasetup andlabdesign ... i 137
PCR setup workareamaterials ...............ciiiiiiiiiiiiinn.. 137
Amplified DNAWoOrk area . ... ..ot i e 138

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using this kit for:

Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility
Planning, Design, Construction, and Moving", National Institute of Justice, 1998

Parentage DNA testing, see the "Guidance for Standards for Parentage
Relationship Testing Laboratories", American Association of Blood Banks, 7th
edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute
quantities of DNA, necessitating precautions to avoid contamination of samples yet
to be amplified (Kwok and Higuchi, 1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at
all times and change them frequently. Close sample tubes when not in use. Limit
aerosol dispersal by handling sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area materials

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

Calculator

Gloves, disposable
Marker pen, permanent
Microcentrifuge

Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free
tube (for master mix preparation)

Microcentrifuge tube rack

Pipette tips, sterile, disposable hydrophobic filter-plugged
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Appendix C PCR work areas
Amplified DNA work area

* Pipettors
* Tube decapper, autoclavable
* \Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

Use only the validated thermal cyclers listed in “Instruments and software
compatibility” on page 17.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in
the user documentation may result in personal injury or damage to the instrument
or device. Ensure that anyone using this product has received instructions in
general safety practices for laboratories and the safety information provided in this
document.

. Before using an instrument or device, read and understand the safety information
provided in the user documentation provided by the manufacturer of the
instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets
(SDSs) and use appropriate personal protective equipment (gloves, gowns, eye
protection, and so on). To obtain SDSs, see the “Documentation and Support”
section in this document.

VeriFiler™ Plus PCR Amplification Kit User Guide 139



Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure
laboratory personnel read and practice the general safety guidelines for chemical
usage, storage, and waste provided below. Consult the relevant SDS for specific
precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. To obtain SDSs, see the "Documentation and Support" section in this
document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment

when handling chemicals (for example, safety glasses, gloves, or protective
clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use

only with sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer cleanup procedures as recommended in the SDS.

Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container

holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

After emptying a waste container, seal it with the cap provided.

Characterize (by analysis if needed) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of

according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special handling,
and disposal limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the
instrument is potentially hazardous. Follow the guidelines noted in the preceding
General Chemical Handling warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste
bottles can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position.
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Safety
Biological hazard safety

Biological hazard safety

g WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

& infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities with
the appropriate safety equipment (for example, physical containment devices). Safety
equipment can also include items for personal protection, such as gloves, coats,
gowns, shoe covers, boots, respirators, face shields, safety glasses, or goggles.
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially biohazardous materials.
Follow all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in laboratory
environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and
Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112,
Revised December 2009; found at:
https://www.cdc.gov/labs/pdf/CDC-
BiosafetymicrobiologicalBiomedicalLaboratories-2009-P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document title Pub. No.
STR kits
VeriFiler™ Plus PCR Amplification Kit—PCR Ampilification and CE Quick Reference MANO017495
VeriFiler™ Plus PCR Amplification Kit—PCR Setup Quick Reference MANO0O017494
Quantification kits
Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User Guide 4485354
Thermal cyclers
ProFlex™ PCR System User Guide MAN0007697
Veriti" Thermal Cycler User Guide 4375799
GeneAmp™ PCR System 9700 Base Module User Manual 4303481
Direct Amplification of Reference Samples Using the VeriFiler" Plus PCR Amplification Kit —
3500 Series Genetic Analyzer
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v1 User Guide 4401661
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v2 User Guide 4476988
HID Updater 3500 Data Collection Software v2.0 User Bulletin —
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software 3.1 User Guide 100025036
3500 Series Data Collection Software v3 User Bulletin: New Features and HID Validation MANO0010812
Summary
3500 Series Data Collection Software v3.1 User Bulletin: New Features and HID Validation MANO0014110
Summary
3500 Series Data Collection Software 4 User Bulletin: New Features and Developmental 100075298
Validation
3130x/ Series Genetic Analyzer
3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
3130/3130xI Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
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Documentation and support
Related documentation

(continued)

Document title Pub. No.
3130/3130xI Genetic Analyzers Getting Started Guide 4352715
3130/3130x! Genetic Analyzers Quick Reference Card 4362825
3130/3130xI Genetic Analyzers AB Navigator Software Administrator Guide 4359472

GeneMapper" ID-X Software all versions

GeneMapper™ ID-X Software Bin Overlap User Bulletin 100029546

GeneMapper™ ID-X Software v1.0

GeneMapper™ ID-X Software v1.0 Getting Started Guide— Basic Features 4375574
GeneMapper™ ID-X Software v1.0 Quick Reference— Basic Features 4375670
GeneMapper™ ID-X Software v1.0 Installation Guide 4476603
GeneMapper™ ID-X Software v1.0 Administrator Guide 4376327
GeneMapper" ID-X Software v1.0 Reference Guide 4375671

GeneMapper " ID-X Software v1.1

GeneMapper™ ID-X Software v1.1 Getting Started Guide— Mixture Analysis Tool 4396773

GeneMapper™ ID-X Software v1.2

GeneMapper™ ID-X Software v1.2 Verification Experiments and Installation Procedures User 4462639
Bulletin

GeneMapper™ ID-X Software v1.2 Quick Reference— Mixture Analysis Tool 4426482
GeneMapper™ ID-X Software v1.2 Reference Guide 4426481

GeneMapper" ID-X Software v1.3

GeneMapper™ ID-X Software v1.3 Verification Experiments and Installation Procedures User 4470483
Bulletin

GeneMapper" ID-X Software v1.4

GeneMapper™ ID-X Software v1.4 New Features and Installation Procedures User Bulletin 4477684

GeneMapper" ID-X Software v1.5

GeneMapper™ ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper™ ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper™ ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
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Documentation and support
Customer and technical support

(continued)
Document title Pub. No.
GeneMapper™ ID-X Software v1.5 Installation Guide 100031706
GeneMapper™ ID-X Software v1.5 Administrator Guide 100031703
GeneMapper" ID-X Software v1.5 Reference Guide 100031707
GeneMapper " ID-X Software v1.6
GeneMapper™ ID-X Software v1.6 New Features and Software Verification User Bulletin 100073905
Precision ID Ancestry Panel and Precision ID Identity Panel
Precision ID Panels with the lon S5™ System Application Guide MANO0015831

Customer and technical support

For support:

* In North America—Send an email to HIDTechSupport@thermofisher.com, or

call 888-821-4443 option 1.

* Outside North America— Contact your local support office.

For the latest services and support information for all locations, go to
thermofisher.com/support to obtain the following information.

* Worldwide contact telephone numbers

* Product support

¢ Order and web support

e Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis,

are available by contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as
set forth in the Life Technologies' General Terms and Conditions of Sale

at www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you

have any questions, please contact Life Technologies at www.thermofisher.com/

support.
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